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LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
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Module: NSIS 1.0j (Sun JRE Component)
Use of this module within the product is governed by the following:
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License: ICU4j License
Module: ICU4j
Copyright © 1995-2001 International Business Machines Corporation and others. All rights reserved.

Oracle may use the software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, and/ort sell copies of the softwate, and to permit persons to whom the software is
furnished to do so, provided that the above copyright notice and the permission notice appear in all copies of
the software and that both the above copyright notice and the permission notice appear in supporting
documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS



ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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Copyright (c) 1990-2005 Info-ZIP. All rights reserved

Use of this dll within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
definition and disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice,
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license, as long as the normal SFX banner has not been removed from the binary or disabled. (3) Altered
versions--including, but not limited to, ports to new operating systems, existing ports with new graphical
interfaces, and dynamic, shared, or static library versions--must be plainly marked as such and must not be
misrepresented as being the original source. Such altered versions also must not be misrepresented as being
Info-ZIP releases--including, but not limited to, labeling of the altered versions with the names “Info-ZIP” (or
any variation thereof, including, but not limited to, different capitalizations), “Pocket UnZip,” “WiZ” or
“MacZip” without the explicit permission of Info-ZIP. Such altered versions are further prohibited from
misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s). (4) Info-ZIP
retains the right to use the names “Info-ZIP,)” “Zip,” “UnZip,” “UnZipSFX,” “WiZ,” “Pocket UnZip,” “Pocket
Zip,” and “MacZip” for its own source and binary releases.

[Definition]: For the purposes of this copyright and license, “Info-ZIP” is defined as the following set of
individuals:

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter Goatley, Ed
Gordon, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul
Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller, Sergio
Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven
M. Schweda, Christian Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White

[Disclaimer:] “This software is provided “as is,” without warranty of any kind, express or implied. In no event
shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential
damages arising out of the use of or inability to use this software.”

License: Paul Johnston

Modules: md5.js

Copyright (C) Paul Johnston 1999 - 2002

Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) Neither the component name nor the names of the copyright holders and contributors may be
used to endorse or promote products detived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

License: Jef Poskanzer

Modules: DES, 3xDES (Sun JRE Components)



Copytight © 2000 by Jef Poskanzer <jef@acme.com>. All rights reserved
Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/ot other matetials provided with the
distribution. (3) Neither the component name nor the name of Jef Poskanzer may be used to endorse or
promote products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

License: Sun Microsystems, Inc.

Modules: Sun Swing Tutorials

Copyright© 1995-2006 Sun Microsystems, Inc. All Rights Reserved.
Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/ot other matetials provided with the
distribution. (3) Neither the component name nor the name of Sun Microsystems, Inc. and contributors may
be used to endorse or promote products derived from the software without specific prior written permission.
(4) Oracle must acknowledge that the software is not designed, licensed or intended for use in the design,
construction, operation or maintenance of any nuclear facility.

THIS SOFTWARE IS PROVIDED “AS IS,” WITHOUT A WARRANTY OF ANY KIND. ALL EXPRESS
OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR
NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. (“SUN”) AND ITS
LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A
RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES.
IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT
OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR
PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF
SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

License: Tom Wu

Module: jsbn library

Copyright © 2003-2005 Tom Wu. All rights reserved

Use of this module within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution.

THE SOFTWARE IS PROVIDED “AS-1S” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL TOM
WU BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES
OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY



THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
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What’s New

New Features in the Oracle Utilities Lode
Analysis User’s Guide

This chapter outlines the new features of the 1.10.0.0 release of the Oracle Utilities Lode Analysis
that are documented in this guide.

New Features for Release 1.10.0.0

Feature Description For more information, refer to...
Write Sun Profile to When creating a sun profile, you have the Create a Sun Profile on page 2-13
Database option of saving the profile to a database or

creating an LSE file.

New Server Executable A new server execution routine, Creating a SEQ File on page 6-3
CSLSServer, replaces the REXX routine
CSLEXEC.CMD. The Sequencer is now
included in the new executable.

Repeater Button in GUI This enhancement supports running the How to Run the Repeater: on page 7-2
repeater for analysis programs from the
user interface.

Target Database for This enhancement supports choosing a Oracle Utilities Load Analysis
Transformation second database to save data to when Sequencer Program Input Tables and
running the Y620 transformation program.  Keywords on page D-1







Preface

Welcome to Oracle Utilities Load Analysis

Welcome

This preface is designed to help you understand the contents and purpose of this manual, as well
as the other resources available to you.

Welcome to Client/Setver Oracle Utlities Load Analysis (also called Oracle Utilities Load
Analysis). This set of software programs has been designed by Oracle Corporation to help utilities
collect, manage, and analyze load research data. Evolved from the original mainframe version of
Oracle Ultilities Load Analysis, it adds the advantages of personal computers and the latest
developments in network architecture, as well as many new tools and features. Its design reflects
more than 20 years of experience in software development for electric and gas utilities.

What Does this Guide Cover?

This guide explains how to use the graphical user interface of Oracle Utilities Load Analysis to
“submit jobs” — that is, how to select a desired program, create and specify the necessary input
files, run the job, and view the results. While this guide covers the mechanics of Aow to use Oracle
Utilities Load Analysis, it does not explain what you can accomplish with the system. It does not
describe the features, functions, or operation of individual programs. (For example, it does not
cover the parameters that you must specify within specific input files for each program.) For that
information, you must refer to the Oracle Utilities Load Analysis Introductory Guides, V'olumes I and 11.
Use this guide as a secondary companion piece to those documents. In fact, if you are a new
Oracle Ultilities Load Analysis user, you’ll probably want to have both manuals open on your desk
as you begin to explore the system.

Welcome to Oracle Utilities Load Analysis iii



How is this Guide Organized?

iv Load Analysis User’s Guide

This guide consists of eight chapters and five appendices:
Chapter One - Overview of Oracle Utilities Load Analysis

Contains information of special interest to both new and existing Oracle Utilities Load Analysis
users. For new users, it defines some basic Oracle Ultilities Load Analysis terms and concepts.

Chapter Two - Getting Started

Explains how to open the Oracle Utilities LLoad Analysis interface, and then provides a brief
overview of the function of each element you’ll see on the “desktop” (menu commands, tool
buttons, etc.). It also describes security restrictions, and how you can customize the system to your
needs and environment using the setup options.

Chapter Three - Working with Jobs

Takes you step by step through the process of submitting a job and viewing the results - the
primary tasks you’ll perform with Oracle Utilities Load Analysis.

Chapter Four - Working with Input Files
Explains how to open, edit, and create Environment, Control, and Common files.
Chapter Five - Managing Data

Explains how to put interval data in a database on the network server, so that it is available for
analysis using the Oracle Utilities Load Analysis programs. It also describes how you can use some
new tools for moving, copying, and deleting cuts (statistics and interval data records).

Chapter Six - The Program Sequencer

Explains how to use the Program Sequencer to “chain” together a series of Oracle Corporation,
user-wtitten, and/or third party programs in a customized sequence. You can run the sequence
immediately using the Oracle Ultilities Load Analysis Graphical User Interface (GUI), or you can
schedule it for delayed future execution and/ot regular petiodic execution using the Windows
Schedule Service.

Chapter Seven - The Repeater

Explains how to use the Repeater to automatically run an analysis program multiple times, each
time with a different Control File and/or Environment File. This is useful if you want to apply a
variety of analysis parameters to different sets of cuts without having to resubmit the job for each
vatiation.

Appendix A - Programs Available via Oracle Utilities Load Analysis

Lists each of the Oracle Utilities L.oad Analysis programs you can use via the Graphical User
Interface (GUI), along with a brief description of the program’s application and a cross reference
to the appropriate user manual for specific instructions.

Appendix B - Oracle Utilities Load Analysis Naming Conventions

Lists each of the Oracle Utilities Load Analysis program/file naming conventions that you will see
in this manual and on the screen, including optional extensions.

Appendix C - Oracle Utilities-Supplied Input Files

Lists each of the test input files that Oracle Corporation supplies with Oracle Utilities Load
Analysis. You can use these files as a starting point for your own work.

Appendix D - Oracle Utilities Load Analysis Sequencer Program Input Tables and
Keywords

Summarizes the commands used to create “SEQ” files for Oracle Utilities Load Analysis
programs. This information is intended to be used in conjunction with Chapter Six: The
Program Sequencer.



Conventions Used in this Manual

This guide assumes that you have a working knowledge of your computer and network, as well as
their operating conventions. For information about Windows operating conventions, see your
Windows documentation.

The following conventions are used in this guide.

Mouse Buttons:

All instructions refer to the left mouse button unless otherwise indicated. Use the 7igh# mouse
button only when specifically instructed.

Typographic Conventions:

How To Get Help

Information that you type is shown in a typeface called Courier New, which looks like typewriter
type. For example: Oracle Utilities.

The names of keys you press are represented by small capital letters. For example: ENTER.
Occasionally, in this manual and on the Oracle Utilities Load Analysis interface, you will see two
key names with a plus sign (+) between them. This indicates that you should press and hold down
the keys in the order specified and release them together. For example, ALT+F5 means that you
should press the ALT key, and while holding it down, press F5.

A sequence of menu commands you select is represented by the name of each menu or command
followed by a small arrow, in boldface type. For example, File->Print means select File from the
desktop or window menu bar, then Print from the pull-down menu that appears.

Customer Support

You can contact Oracle Support personnel at http://metalink.oracle.com. My Oracle Support
offers you secure, real-time access to Oracle experts on the complete Oracle Utilities Load
Analysis system. It also provides ground breaking personalized & proactive support capabilities
that help reduce unplanned down time and improve system stability. Leverage the Internet for
immediate access to 24/7 support and get the critical and timely information you need for running
your business.

Welcome to Oracle Utilities Load Analysis v



Additional Documentation

User Feedback

vi Load Analysis User’s Guide

In addition to the Oracle Utilities Ioad Analysis Introductory Guides, another reference you may find
helpful is the Oracle Utilities Load Analysis Quick Reference Guide — a concise summary of program
names, input file commands and parameters, standard codes, and other important information for
the basic Oracle Ultilities Load Analysis system and its extensions.

This document will be refined and updated over time. We would appreciate your help in
improving it. If you have suggestions for adding new topics or for clarifying existing explanations,
please let us know by calling the Help Line or by completing and returning the Customer
Feedback form at the back of this guide.



Chapter One

Overview of Oracle Utilities Load Analysis

This chapter provides a brief overview of Oracle Utilities LLoad Analysis. It begins by generally
describing how you work with the system — an especially useful section for new users since it
covers some key terms and concepts referred to throughout the rest of this guide. Next you will
find a brief overview of the features introduced with each new release.

How Do You Work with Client/Server Oracle Utilities Load Analy-

Sis?

Input Files

The Oracle Utilities L.oad Analysis system is a suite of software programs developed by Oracle
Corporation to help utilities conduct successful load research programs. It incorporates programs
for interval data input, editing, validation, analysis, reporting, graphing, and more. (A complete list
of the programs available with this version of Oracle Utilities LLoad Analysis is provided in
Appendix A: Programs Available via Oracle Utilities Load Analysis.)

You accomplish tasks by selecting a program to process the data, specifying input files,
identifying the database that holds the data with which you wish to work, and viewing the
outputs (also called Results). Users interact with the system via a point-and-click graphical user
interface (GUI).

Most Oracle Utilities Load Analysis programs require you to specify two types of input files:
Control Files and Environment files. A Control File is often a list of the specific data records
(called “cuts”) that you want to apply the program to, such as customer interval data or computed
statistics. An Environment File is the set of commands and parameters that define how the
program will process the data.

Many programs, such as the analysis and reporting programs, also use one or more Common files
to define various schedules:

*  Holiday File: a list of all national and local holidays observed in your service territory.

*  Time-of-Use Schedule File: a schedule of on-, off-, and shoulder peak periods.

*  Season File: a schedule applying different TOU schedules to seasons throughout the year.
*  Demand Period File: a schedule of “on-demand” periods.

*  User-Specified Day File: a schedule of user-defined days to be averaged together in an
analysis.

*  Billing Cycle File: a schedule of billing cycles for the Billed Energy Program.
*  Peak Days File: a schedule of Peak Days for the Daytype Analysis Program.
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Output Files
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These ate called “Common files” because they reflect the policies of your facility, are typically
accessed by all Oracle Utdlities Load Analysis users, and are located in your Common\Data folder
(more on that later).

Oracle Utilities Load Analysis has several types of interval databases to keep track of data in the
different stages of the input-validation-analysis cycle. The CLDB (Current Load Database)
contains raw customer interval data that is in the process of being verified. The ALDB (Archive
Load Database) typically contains load data that has been checked and edited for completeness
and reliability, and is considered ready for analysis. The ELDB (Extracted Load Database) is the
working database for the analysis programs. You can use the SLDB (Statistics Load Database) to
archive selected subsets of the ELDB. The GLDB (Generator Level Database) is the working
database for the Cost of Service Interface. The RLDB (Rates Level Database) is the archive
version of the GLDB.

Your facility may have multiple databases of each type.

Most Oracle Utilities Load Analysis programs produce three types of output files:

*  Reports: Oracle Utilities Load Analysis combines all reports into one file called
“SYSPRINT”. The system adds an index to the end of the file, so you can quickly locate a
desired report.

*  Data: Data files can include individual customer statistics files and keylists.

*  Log: System log containing information about the program run. This is useful if there is a
problem with the job.



Chapter Two

Getting Started

This chapter explains how to open and close the Oracle Utilities Load Analysis desktop, your
primary work area. To help you get oriented quickly, it also gives a brief overview of each
command and tool available to you on the desktop, as well as the use of some function keys.
Finally, it describes how you can customize your system, and how you can view a list of your
system privileges.
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Starting and Ending a Oracle Utilities Load Analysis Session

This section explains how to start and close the Oracle Utilities Load Analysis Graphical User
Interface and log on to the server.

How to Start Oracle Utilities oad Analysis:

1. At the Windows desktop, click the Start button. Then select
Programs->Oracle Utilities->Load Analysis Client 01.10.0.00.00

(If the options described above do not appear on your system, refer to your Windows
documentation, or consult your System Administrator. There are many ways to start a
program in Windows, and your system may be set up with different programs groups or other
customizations.)

After a few moments, the Oracle Utilities Load Analysis desktop appears on your screen. All
Oracle Ultilities Load Analysis functions can be accessed from this window.

Note: The server that you log on to 2. Oplzbmz/. LOg on to the server. (Thls is the default state — 10gg€d on.)

—and whether or not logon is . . . .

automatic — is determined by Almost all work that you’ll perform with Oracle Utilities Load Analysis requires that you log
your setup options. See Options on to the Oracle Utilities Load Analysis Servet.

on page 2-7 for details. . . .
Depending upon how your system is configured, the system may automatically log you on to

the server when you open the Oracle Ultilities Load Analysis interface. You can tell whether or
not you ate logged on by looking at the Logon/Logoff button in the toolbar.

Logged Off: I Logged On: (pushed in)

When you have successfully connected to the server, a message appears in the information
box at the bottom of the desktop window, “User (your network ID) logged on
CSL* server (server name)”. You are now ready to begin working with Oracle
Utilities Load Analysis.

How to Close the Oracle Utilities oad Analysis Interface:
1. Log off the server by clicking the Logoff button.

2. Close the interface. There are four alternate methods for closing the Oracle Utilities Load
Analysis interface (all produce the same result):

¢ Select File->Exit.
e Press ALT + F4.
*  Press CTRL + F12.

¢ Click the Close button (X) in the upper right corner of the window.
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Getting Acquainted with the Oracle Utilities Load Analysis

Desktop

NOTE: In addition, some
functions can be performed using
the Function Keys on your
keyboard. See Function Keys on
page 2-6 for more information.

Toolbar

The Oracle Ultilities L.oad Analysis desktop is your starting point for all Oracle Utilities L.oad
Analysis functions. You can interact with the system either via the Menu Bar commands or the
Toolbar.

The Toolbar gives you quick access to Oracle Utilities Load Analysis’s most frequently used tools
and commands. Just click the desired button to submit a job, view results, and more.

The following describes the function of each Toolbar button. Additional details are provided in
the remainder of this guide.

) ) o P

e &} Vo |
Logon/Logoff | Refresh Submit Refresh Queue Refresh Results | Quick Viewer | Custom Tool 1@  Custom Tool 2:

Icon Description

Logon/Logoff: Log on to ot log off from the Oracle Utlities Load
_J _J Analysis server. Also acts as a status button; that is, if the button is bright,
you are already logged on, if it is dark, you are logged off.

Refresh Submit: Refreshes the submit screens. See Chapter Three:
Working with Jobs.

Refresh Submit

Refresh Queue: Refreshes the queue of previously-submitted jobs on the
> server. See Chapter Three: Working with Jobs.

Refresh Queue

Refresh Results: Refreshes files in Oracle Utilities Load Analysis job
directories; that is, the results of completed Oracle Ultilities Load Analysis
jobs. Also gives you access to both Display Tool and other viewers. See
Chapter Three: Working with Jobs.

Refresh Results

Quick Viewer: Provides brief explanations of selected program functions.

3

Quick Viewer
» Custom Tool 1: Open a configured Windows accessory. See Options on
v page 2-7.

Custom Tool 2: Open a configured Windows accessory. See Options on

» page 2-7.
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Menu Commands

Any of the commands and tools that you can activate using the Toolbar (just described) can also
be accessed using Menu bar. In addition, there are a few commands that you can use only via the

Menu bar:
Click To
File-»

Transfer Type Utility Opens the Oracle Utilities Load Analysis Type
Transfer Utility, used for convert multi-typed
information from one CSLSINFO.MDB to
another. See Chapter Four: Working with
Input Files.

Setup Configures Oracle Utilities Load Analysis to
your specific needs and environment.

Server Configuration Available only to System Administrator. See
the Oracle Utilities Load Analysis Configuration
Guide.

Exit Close the Oracle Utilities Load Analysis
interface.

Tools-»

Logon Logs the current user on to the server.

Logoff Logs the current user off the server.

Restrictions View a list summarizing which programs and
databases you have been granted access to by
the System Administrator. See Restrictions
on page 2-19.

Tooll Opens the tool specified as Custom Tool 1 on
the Tools tab on the Options dialog.

See Options on page 2-7.

Tool2 Opens the tool specified as Custom Tool 2 on
the Tools tab on the Options dialog,
See Options on page 2-7.

Interval Data Manager Opens Internet Explorer to the URL specified
as the “IDM Home Address” on the Tools tab
of the Setup dialog.

See Tools on page 2-8.

SunRise-Set Calculator Opens the Sunrise - Sunset Calculator.

See Sunrise - Sunset Calculator on page 2-
12.

Edit INI File Opens the .ini file for editing,

Options User-selectable options for configuring Oracle
Utilities Load Analysis to your needs and
environment
See Options on page 2-7.

Additional Tools These tools can be chosen in the Options

menu, as explained above.
Sy
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Help Displays a drop-down list of options, including

User Documentation (a drop-down list of
Oracle Utilities Load Analysis manuals that
can be accessed in PDF format), About...
(About Oracle Utilities Load Analysis), and a
link to the Oracle Utilities Support web site.
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Function Keys

Some functions can be performed in Oracle Utilities LLoad Analysis by use of the Function Keys.
Some of these are unique to Oracle Utilities LLoad Analysis, and some are basic Windows functions
used in Oracle Utilities Load Analysis.

Press Result

Ctrl + F1 Opens the Oracle Utilities I oad Analysis Quick
Reference Guide.

Ctrl + F2 Opens the Oracle Utilities Ioad Analysis Users
Guide.

Ctrl + F3 Opens the Oracle Utilities Ioad Analysis
Configuration Guide.

Ctrl + F4 Opens the Oracle Utilities Load Analysis Load
Data Management User’s Guide.

Ctrl + F5 Opens the Oracle Utilities Load Analysis Load
Data Analysis User’s Guide.

Ctrl + F12 Exits the Oracle Utilities Load Analysis
application

Shift + Ctrl + F6 Opens the Oracle Utilities Ioad Analysis Sampling
Package User’s Guide.

Shift + Ctrl + F8 Opens the Oracle Utilities Ioad Analysis Cost of
Service Interface User’s Guide.

Alt + F4 (Windows function) Exits the Oracle Ultilities Load Analysis
application

F5 Opens Internet Explorer to the URL specified
as the “IDM Home Address” on the Tools tab
of the Setup dialog.
See Tools on page 2-8.

Fo

For input files: Allows you to select and include a Control File
or Environment File in the File list box. Use a
file not in your local data folder structure. This
file is for one-time use only; the selection will
be reset when you change the Submit panels
For output files: Allows you to specify path name together with

output filename

F7 Opens the Server Configuration file
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Options

Setup

Oracle Utilities Load Analysis makes it possible to configure the system to your particular needs
and environment, using Tools-»Options.

When you select Options, the system displays a set of tab pages, as described below. The default
values are shown here. You can change these settings as desired, because they affect work on your
workstation only.

File Paths

Tools

This tab defines the path to the directory containing your input files.

*  Ctl and Env Files: The path and directory containing your Control and Environment files.
Oracle Utilities Load Analysis uses this path when displaying the names of available files in
the Submit Form and File Composer windows.

*  Sequencer Files Path: The path to the directory containing your sequencer files. Oracle
Utilities Load Analysis uses this path to populate the Sequencer Files drop down in the
"SEQR Sequencet" program panel

Checking the Maintain Window State box causes each window’s state (as it pertains to
minimization/maximization) to be maintained; that is, the windows will not maximize by
themselves if this item is checked. If left unchecked, default Windows behavior remains in effect.

This tab defines the Custom Tools accessories found in the Oracle Utilities Load Analysis
toolbar. By default, the entries here point to Windows accessories that are supplied with your
operating system, but you can opt to use other programs if you have them.

When you select File->Setup, the system displays another set of tab pages for customizing your
configuration. Because most of the settings on these tab pages involve resources used by all Oracle
Utilities Load Analysis users, they are typically set up for you by the System Administrator when
Oracle Utilities Load Analysis is installed. (The values displayed for your system may differ from
those shown here.)

The Setup window is organized into three tabs:
*  General — This tabs contains general user as well as connection/database login information.
*  Options — All available Client GUI configuration options are stored in this tab.

*  Advanced — Stores advanced configuration settings that normally do not require changes.
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General
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Options || Advanced

Server Connection User Info
Server Name [10.149.189.248 | User Company  [Oracle |
Userld [thoig2 | User  [Trien Ho |

Relational Database Login

Database User Name [|313r

DB Password I

CDBC Data Source |I 0149182 .124\2582105

DB Qualifier [lstar

Server Name: The network name of the Oracle Utilities L.oad Analysis server.

User Id: The ID of the user that will be using this workstation. The ID here should match an
entry in the CSLSTAR.USR File. The access privileges set in that file will determine what
functions the user identified here can have from this workstation.

User Company and User Name: The information in these fields appeats on the Oracle
Utilities L.oad Analysis title screen when the application is launched. It has no other purpose.

Database User Name: User ID used to connect to the Oracle Utilities Data Repository
(used when accessing interval data stored in Relational tables in the Oracle Ultilities Data
Repository).

DB Password: Database password used to connect to the Oracle Ultilities Data Repository
(used when accessing interval data stored in Relational tables in the Oracle Utilities Data
Repository). Note: This password must be supplied at login if any other RDB connection
fields have been populated.

Data Source: The Data Source name for the Oracle Utilities Data Repository (used when
accessing interval data stored in Relational tables in the Oracle Utilities Data Repository).

¢ For Oracle databases, this is the Oracle TNS Name for the data source, from the
TNS_NAMES.ora file (typically located in the \\ <machine>\oracle\network\admin
directory)

DB Qualifier: Database qualifier used to connect to the Oracle Utilities Data Repository
(used when accessing interval data stored in Relational tables in the Oracle Ultilities Data
Repository).



Getting Acquainted with the Oracle Utilities Load Analysis Desktop

Options

Aphvanced

Results Panel Oueue Panel
Default Report Viewer
” = ] Job Clear
[ rowse O Auto (%) Manual

Alternate Job Directory Viewwer
[C:\Program File='EditPlus Jediplus exe |[ Browse ]

1000, Queue Refresh Rate (ms)
Show System Files

Job Folders Submit Panel and Editor Settings
(%) Order jobs by date External Editor
f Ordr jobs by job name 'C:WNDOWShotepad exe |[ Browwse
DM Home Address
Report View Behavior | |
Produce warning if Enforce upper-case in editor

2| yj ewing & report Open with Associated

Display DB Physical Names:
larger than (MB) Program [[] Display -

[] Use Graphical Key Generator?

e Default Report Viewer: Oracle Utilities LLoad Analysis allows you to use a third-party
program (e.g. Microsoft Word or Notepad) to view SYSPRINT.HTM files. If you want to use
this feature, specify the full path and executable name of the desired program, and uncheck
“Open with Associated Program.”

e Alternate Job Directory Viewer: The full path and executable name of an alternate program
used to view results files in the job directory.

*  Job Folders: Select how to sort results, by Create Date or Job Name (default). You may
change this setting by right-clicking a Job Folder in the Results panel and selecting “Order by
Date.”

*  Report View Behavior: These options allow you to specify how you view reports:

*  Produce warning if viewing a report larger than (MB): Warns users if they are about
to view a report that is very large. The default is 10 MB and a popup a message will
appear allowing the user to cancel the load if the file is larger than the preset limit.

*  Open with Associated Program: Check this option to open Report files with the
program associated with the file type. (Recommended.)

*  Queue Panel:

*  Job Clear: Select how to clear jobs, Auto (automatically clear jobs) or Manual (manually
clear jobs).

*  Queue Refresh Rate: Specify how often the queue is refreshed from the server (in
milliseconds).

*  External Editor: The full path and executable name of the program (i.e., Notepad) used to
edit files such as INP or LSE files.

* IDM Home Address: The URL of the Oracle Utilities Energy Information Platform that
includes Interval Data Manager (i.e., http://servername/lodestar/css). To open the Oracle
Utilities Energy Information Platform at this URL, select Tools->Interval Data Manager
(or click F5).

*  Enforce upper-case in Editor: When this option is selected, any and all edits are done in
upper-case letters. Editing in lower-case or mixed-cased is disabled. (Recommended.)

*  Display DB Physical Names: To display the physical names of databases (set up in the
CSLSTAR.DB file), click Yes (database Descriptions appear in brackets “<< >>”). To
display database Descriptions only, click No (default).
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Advanced

Use Graphical Key Generator?: Select whether or not to use the Graphical Key Generator.
(Not recommended.)

Record Definition Utility Settings:

*  Maximum number of pages: Specifies the number of pages (1 - 999) the Record
Definition Utility will process when loading a Population Data File. The default is 50.
Any invalid input will be reset to the default.

*  Records per page: Specifies the number of records (1 - 999) to load per page. The
default is 50. Any invalid input will be reset to the default.

These fields are by default disabled and are automatically configured by the client, based on the

user’s current server and User ID information. Unless you have special configuration settings, you

should not need to change settings here. Doing so can adversely affect your application's job

submissions to the server. Values can be manually overridden by clicking on the associating check

box and then changing the values.
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General | Options

[] Server Path Configur ation

|:| RDB Common Schedule Configuration File Locations

Server Path Configuration: In this screen, you can either enter the paths in the fields or
click Browse... to search the network.

*  Production Input Path: Path to the directory on the server that holds the Production
Input files.

*  Common Files: Path to the directory on the server that holds the Common files.
*  Job Path: Path to the current user’s Job folder.

RDB Common Schedule Configuration File Locations: These options specify
configuration files used by Oracle Utilities Load Analysis, when accessing data in the Oracle
Utilities Data Repository.

*  Holiday File Configuration File: A configuration file that specifies holiday lists stored
in the Oracle Utilities Data Repository.

*  TOU Configuration File: A configuration file that specifies that Oracle Ultilities Load
Analysis should use Time-of-Use schedules defined in the Oracle Utilities Data
Repository.

*  Season Configuration File: A configuration file that specifies that Oracle Utilities Load
Analysis should use Time-of-Use schedules defined in the Oracle Utilities Data
Repository.
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*  UserDay Configuration File: A configuration file that specifies user day lists stored in
the Oracle Utilities Data Repository.
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Sunrise - Sunset Calculator

The Sunrise - Sunset Calculator is a tool that allows users to calculate sunrise and sunset times for
any point on the globe. This can aid generating profiles that correspond to daylight or darkness
hours.

How to calculate sunrise and sunset for a specific location over a specified data
range:

1. Select Tools->SunRise-Set Calculator.

2. Select the location in which you wish to calculate sunrise-sunset times for. If your location
isn't already defined, you add your location by doing the following:

a. Enter a name for your new location in the Select Location field.

b.  Enter the latitude for the location in the Latitude field. Latitudes should be entered as
<degrees>.<minutes> North. For example, a latitude of 54 degrees, 19 minutes North
would be entered as "054.19." Coordinates South are designated with negative values.
For example a latitude of 54 degtees, 19 minutes South would be entered as "-54.19".

c.  Enter the longitude for the location in the Longitude field. Longitudes should be
entered as <degrees>.<minutes> West. For example, a latitude of 87 degrees, 54
minutes West would be entered as "87.54." Coordinates East are designated with

negative values. For example a latitude of 87 degrees, 54 minutes East would be entered
as "-87.54".

d. Enter the Time Zone Standard Name for the location in the TZ Standard Name field.
U.S. values are EST, CST, MST and PST. If you require a timezone other than the default,
you will need to configure your LSCALENDAR.CFG.XML file located in your /CFG
directory.

e. Click "Save Location" once you've provided all necessary input for your new location.

3. Optional. Enter any necessary adjustments (in numbers of minutes) for the location in the
Sunrise and Sunset fields in the Adjustments box. These allow for minor adjustments to the
sunrise and sunset times to account for obstructions or other factors that may impact when
the sun rises or sets in the location.

4. Select the Start Date and Stop Date for the date range.

5. Click Calculate. The sunrise and sunset times for the supplied date range appear in the
Sunrise Sunset Results dialog.
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Sunrise-Sunset Results

Sunrise - Sunset times are calculated for each day in the date range provided. You should do a

quick check that these times are accurate, that sunrise - sunset times are occurring the expected

approximate times. If not, you should be go back and check your location inputs and make

adjustments as necessary.

With these Sunrise - Sunset results, you can:

Export results to a COSI File: Results are exported as a COSI file that can be used with the
SUN command in the G130 Control File used by the Cost of Service Interface - Electric
(COSI) program.

Export results to CSV: Results are exported into a comma-separated (CSV) file

Create a Profile: Create a cut profile and import it into a database or save it in LSE format.

Example: COSI format

SUN

07
07
07
07

:08
:09
:10
112

17:47
17:45
17:44
17:42

Example: CSV format

Sunrise, Sunset

10/24/2004 7:08:31 AM,10/24/2004 5:47:01 PM
10/25/2004 7:09:45 AM,10/25/2004 5:45:37 PM
10/26/2004 7:10:59 AM,10/26/2004 5:44:15 PM
10/27/2004 7:12:14 AM,10/27/2004 5:42:54 PM

To export results, click either Export COSI File or Export CSV. A Save As dialog opens
allowing you to save the file.

Create a Sun Profile
Sun profiles are interval data cuts that represent usage based on the sunrise-sunset calculations.

How to create a Sun profile:

Click Create Profile.

1.

The Sun Profile Generator window opens.

Specify the Profile Destination for the profile:

Select Database if you want to write the profile to a database. Select the database you
want to import the file into in the Database drop-down list.

Select LSE if you want to create an LSE file. Specify the name and location in which you
wish to create your LSE file in the Output LSE Filename field.

Supply Function Parameters specific to the profile you wish to create:

RecordedID: Enter the Recorder ID, name, or CUSTID for this profile.
Channel: Specify the channel for this profile. The default is 1.

SPI: Specify the aggregation level in which you wish to create this profile. The default is
900 Seconds Per Interval.

Energy to allocate (KWh): Specify the desired total energy to allocate for this profile.

Descriptor: Specify the description attached to this profile. The description can contain
up to 80 characters.
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4.
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Unit of Measure: Select the unit of measure to assign to this profile. The default is
KWh.

Ramp Duration (Seconds): Street Lighting doesn't consume at 100% energy usage
instantly when turned on: they gradually increase in energy usage over a period of time.
Ramp duration is used to simulate ramping up (power on) and down (power down) of
energy that occurs in street lighting for each sunrise - sunset time. These ramps are
centered on the sunrise or sunset time for each day. Specify the time it takes to power up
and down for your profile. The default is 900 seconds per interval.

DST Participant: Check to indicate whether your profile participates in DST. If your
location does not observe Daylight Savings Time changes, uncheck this checkbox.

Click Create Profile.

If you are importing the file into a database, the job will be submitted to X111 using a
predefined COMMMONN\DATA defaulted env file. No AXDB processing will take
place and the cut will always be loaded “Valid Replace”.

The env file used is the default TGX11SPENV:

LOA VAL REP
If you are creating an LSE file, once the file is created it can be imported via Production
/ Direct Input or uploaded to Interval Data Manager (IDM).

Note: The output report will contain a reference to an LSE file that is created
in the COMMON\LOAD foldet. You may ignore this references as this is a
temporary file that is removed after the profile is completed.
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Defining Holidays, Time Of Use Periods, Seasons, and User Days
in the Oracle Utilities Data Repository

Oracle Utilities Load Analysis can access data stored in relational tables in the Oracle Utilities Data
Repository. This includes interval data as well as the following data:

* Holiday Lists and Holidays

* Time of Use Periods and Schedules

*  Season Periods and Schedules

*  User-Specified Day Lists and User-Specified Days

This section describes how to set up this data in the Oracle Utilities Data Repository, and how to
have Oracle Utilities Load Analysis use this data.

Records in these tables should be created using the Data Navigator application, available through
the Oracle Utilities Energy Information Platform web user interface. Refer to the Oracle Utilities
Energy Information Platform User’s Guide for more information about using Data Navigator.

Holiday Lists and Holidays

Holiday Lists and holidays are defined in the Holiday List and Holiday tables in the Oracle Utilities
Data Repository.

Holiday Lists
Holiday lists are user-defined lists of holidays. For each holiday list you wish to define, create a
record in the Holiday List table. Records in this table contain the following fields:

*  Name: the name of the holiday list.

*  Note: an optional note regarding the holiday list.

Holidays
For each holiday you wish to define, create a record in the Holiday table. Records in this table
contain the following fields:

*  Holiday List: the Holiday List (from the Holiday List table) to which the holiday belongs.
*  Date: the date on which the holiday is observed.

*  Name: the name of the holiday.
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Holiday File Configuration File
The Holiday File configuration file is a *.cfg file stored in the
C:\LODESTAR\CSLSTAR91\Binw directory (on client machines) or the
C:\LODESTAR\CSLSTAR91\Common\Data ditectory (on the server) that specifies the holiday
lists available. The format of this file is:

RDB/<HOLIDAY LIST NAME>

where:

* <HOLIDAY_LIST_NAME> is the name of a holiday list from the Holiday List table.

The Holiday File configuration file can include multiple entries, one for each holiday list.

You select the Holiday File configuration file on the Configuration tab of the Setup dialog.
Example

Below is a sample Holiday File configuration file.

RDB/2003 Holidays
RDB/2004 Holidays
RDB/2005 Holidays

Time of Use Periods and Schedules

Time of use (TOU) periods and schedules define periods of use (On Peak, Off Peak, etc.) used
with Oracle Utilities Load Analysiss programs. Time of Use Petiods and Schedules are defined in
the LS Time of Use Schedule and LS Time of Use Period tables in the Oracle Utilities Data
Repository.

LS Time of Use Schedule

For each time of use schedule you wish to define, create a record in the LS Time of Use Schedule
table. Records in this table contain the following fields:

* TOU Schedule Number: a number that represents the TOU schedule.

*  Note: an optional note regarding the TOU schedule.

LS Time of Use Period

For each time of use period you wish to define, create a record in the LS Time of Use Period table.
Records in this table contain the following fields:

* LS Time of Use Schedule: the TOU schedule (from the LS Time of Use Schedule table) to
which the period belongs.

*  TOU Period Number: a number that represents the TOU period.
* TOU Period Name: a name for the TOU period (On Peak, Off Peak, etc.)

*  Day List: a list of numbers representing the days to which the TOU period applies, based on
the following;:

*  Sunday =1

*  Monday = 2

*  Tuesday =3

*  Wednesday = 4
e Thursday =5

* Friday =6

e Saturday =7
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*  Holiday = 8

Example: Monday through Friday would be represented as “23456.” Saturdays, Sundays, and
Holidays would be represented as “178.”

*  Start time: the start time for the TOU petiod.

*  Stop Time: the stop time for the TOU period.

TOU File Configuration File
The TOU configuration file is a *.cfg file stored in the C:\LODESTAR\CSLSTAR91\Binw
directory (on client machines) ot the C:\LODESTAR\CSLSTAR91\Common\Data directory
(on the server) that specifies that the Oracle Utilities Load Analysis programs should use the Time
of Use periods and Schedules defined in the Oracle Utilities Data Repository. This file contains
only a single keyword:

RDB/

You select the TOU configuration file on the Configuration tab of the Setup dialog.

Season Periods and Schedules

Season periods and schedules define seasons (Summer, Winter, Spring, Fall, or others) for use with
Oracle Utilities Load Analysis programs. Seasons ate defined in the LS Season Schedule, LS
Season Period, and LS Season Dates tables in the Oracle Utilities Data Repository.

LS Season Schedule

For each season schedule you wish to define, create a record in the LS Season Schedule table.
Records in this table contain the following fields:

*  Season Schedule Number: a number that represents the season schedule.

*  Note: an optional note regarding the season schedule.

LS Season Period

For each season period you wish to define, create a record in the LS Season Period table. Records
in this table contain the following fields:

* LS Season Schedule: the season schedule (from the LS Season Schedule table) to which the
period belongs.

* LS Time of Use Schedule: the TOU schedule (from the LS Time of Use Schedule table) to
which the period belongs.

*  Season Period Number: a number that represents the season period.

*  Season Period Name: a name for the season period (Winter, Summer, etc.)

LS Season Dates
Records in the LS Season Dates table specify the dates for each season period. Records in this
table contain the following fields:

* LS Season Period: the season period (from the LS Season Period table) to which the dates
will apply.

*  Season Start time: the start time for the season petiod.

*  Season Stop Time: the stop time for the season period.
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Season File Configuration File
The Season configuration file is a *.cfg file stored in the C:\LODESTAR\CSLSTAR91\Binw
directory (on client machines) ot the C:\LODESTAR\CSLSTAR91\Common\Data directory
(on the server) that specifies that the Oracle Utilities Load Analysis programs should use the
Season periods and Schedules defined in the Oracle Utilities Data Repository. This file contains
only a single keyword:

RDB/

You select the Season configuration file on the Advanced tab of the Setup dialog;

User-Specified Day Lists and User-Specified Days

User-Specified Day Lists and user-specified Days are defined in the User-Specified Day List and
User-Specified Day tables in the Oracle Utilities Data Repository.

User-Specified Day Lists
User-Specified Day lists are user-defined lists of user-specified days. For each list you wish to
define, create a record in the User-Specified Day List table. Records in this table contain the
following fields:

¢  Name: the name of the list.

*  Note: an optional note regarding the list.

User-Specified Days
For each user-specified day you wish to define, create a record in the User-Specified Day table.
Records in this table contain the following fields:

*  User-Specified Day List: the User-Specified Day List (from the User-Specified Day List
table) to which the day belongs.

*  Date: the date of the user-specified day.
*  User Day Label 1: 2 name for the user-specified day.

*  User Day Label 2: a second name for the user-specified day.

UserDay File Configuration File
The UsetDay configuration file is a *.cfg file stored in the C:\LODESTAR\CSLSTAR91\Binw
directory (on client machines) ot the C:\LODESTAR\CSLSTAR91\Common\Data directory
(on the server) that specifies the user-specified day lists available. The format of this file is:

RDB/<DAY LIST NAME>
where:

*  <DAY_LIST_NAME?> is the name of a list from the a name for the User-Specified Day
List table.

The UserDay configuration file can include multiple entries, one for each list.

You select the UserDay configuration file on the Configuration tab of the Setup dialog;
Example

Below is a sample UserDay configuration file.

RDB/2004 LJP_ Days
RDB/2004 RJC Days
RDB/2004 THO Days
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Restrictions

Restrictions

The Oracle Utilities Load Analysis Restrictions window (Tools->Restrictions) displays a list
of the access privileges that the System Administrator has granted to your logon ID. Specifically, it

shows which programs and databases you can and cannot use. This information is view-only; you
cannot modify it here.
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Chapter Three

Working with Jobs

This chapter explains how to use Oracle Utilities Load Analysis to “submit a job” — that is, to
select the desired Oracle Utilities Load Analysis application program, specify the necessary inputs,
run the job, and view the results. It also includes a brief overview of the tools

Oracle Utilities Load Analysis provides to work with your results; e.g,, to view, edit, export, graph,
delete, and more.

Submitting a Job

The process of submitting a job consists of just a few steps: log on to the server, open the Submit
Panel, specify the desired inputs, run the program, and finally view the results.

Important Note to New Oracle Utilities Load Analysis Users: If you have never worked with
Oracle Utilities Load Analysis before, be sure to refer also to the Oracle Utilities L.oad Analysis
User’s Manual that describes the program with which you wish to work. Those documents provide
useful background information as well as the specific instructions you'll need to prepare the
required inputs and evaluate the results for all programs in the Oracle Utilities L.oad Analysis
system. The table in Appendix A: Programs Available via Oracle Utilities Load Analysis

directs you to the appropriate reference for each program available in Oracle Utilities Load
Analysis.
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Logging on to the Server
Begin at the Client Server Oracle Utilities Load Analysis desktop (shown below).

1. If you are not already logged on to the server, click the Logon button. For more information
about logging on to the server, see Chapter Two: Getting Started.

Logged Off: | Logged On: ]

Selecting a Program

1. Select a program from the Programs Panel on the left by clicking on it:

Programs

D’ Administration

M Analysis

- §] Cost of Service

|$] G130 COSI Eneray Allocatar

Iil] G210 COSI Allocate Sampling Error
|$] G250 COSI Allocate TD Losses

|§] G410 COST Rates Reporter

|$] G610 COST Cost Allocator

il] G630 COSI Probability of Dispatch
|§] £120 COSI 5LDE ELDE Extraction
- Editing

Extract Data

Input

Other

Query

Reporting

&% Sampling

- Wt Validation

&

[URE g s

[ I e B B e B e O e W e B

al
H
H
]..
al
H
H
H

When you make your selection, the programs belonging to that category appear in tree
format below it. (A complete list of programs available via the Oracle Utilities L.oad Analysis
interface is provided in Appendix A: Programs Available via Oracle Utilities Load
Analysis for your convenience.)

2. Select a program.

Programs

D’ Administration

M Analysis

E| ﬁl] Cost of Service

(SR G150 COSI Energy Allocator
,1'] G210 COSI Allocate Sampling Error
|$] G250 COSI Allocate TD Losses

|$] G410 COSI Rates Reporter

[$] G610 COSI Cost Allocator

Ii'] G630 COSI Probability of Dispatch
|§] 7120 COSI SLDB ELDE Extraction

Note: When you make your selection, the fields in the Submit Panel are
automatically updated to match the type of inputs. For example, if you select an
analysis program the Submit Panel will contain a button that enables you to use
the Repeater to run the program multiple times. See Chapter 7: The Repeater
for more information about the Repeater.

Customizing the Programs Panel

You can save a list of frequently used ot “favotite” programs and hide/display program IDs on
the Programs panel.

To save a program to your Favorites list, right-click and select “Add to Favorites.”

To view your saved favorites, right-click and select “Show Favorites.” The Programs panel displays
a list of saved favorite programs. To remove a program from your favorites list, right-click and
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select “Remove from Favorites:” To restore the Programs panel to the default list of programs,
right-click and deselect “Show Favorites” again.

To hide the program IDs (X110, etc.) right-click and select “Hide Program ID.” To restore the
program IDs, right-click and deselect “Hide Program 1D.”
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Specifying Desired

Inputs and Outputs

The fields displayed on the Submit Panel vary from program to program. In general, there are
fields to specify required or optional inputs, and occasionally to assign names to output files. (For
example, in the illustration below, the Standard Load Analysis Program requires a Control File, an
Environment File, and a version of the ELDB. It also gives you the opportunity to assign a name
to the Individual Customer Statistics File and Key List File produced by the program at the end of
its run.) There may also be a panel hidden underneath, accessed by clicking on the page ear, in
which you can specify optional “Common files,” e.g., Time-Of-Use and Holiday files.

The purpose and contents of each input and output file are beyond the scope of this document.
The box at the right provides a brief definition of each file type to help orient new users. See the
Oracle Utilities Ioad Analysis Ioad Data Guides for more information. Note: Appendix A:
Programs Available via Oracle Utilities Load Analysis lists the specific Oracle Utilities 1.oad
Analysis manual that you must refer to for detailed information abont each program’s inputs and outputs.

The illustration below shows the types of elements you will encounter on a typical Submit Panel.

To use an existing version of an input file:
Click the List button to the right of the text

box. A list of files you

saved appears. Click on a file name to

select it. If a file name

doesn’t appear, it may be because it hasn’t

been “typed” - see Ch
with Input Files.

have previously Specify the target database.

that you expect

Use New to
create a new
Control File or
Environment

apter Four: Working

Submit [J¥]
GLDB EXAMPLE GLDB ' =l
Control File ' =l |
Environment File =l ﬂ
Holiday File (Opt.} none =8

Use Edit to modify an
existing Control File or
Environment File.

Note: Databases are listed alphabetically within each database type, in the following order:

+ AXDB
+ CLDB
« ALDB
* ELDB
» SLDB

* GLDB
* RLDB

To disable this option and display databases in the same order as on the Server Configuration -
Databases dialog, include the following in the your ini file:

SortDBNames=NO
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In general, most Oracle Utilities Load Analysis programs requite you to specify
three types of input files and a database:

*  Control File: a list of the specific data records that you want to apply the
program to. Typical Control Files consists of the keys of load data records or
statistics records.

Environment File: a set of commands that define how you want the
program to process the data.

Database (e.g., ELDB): contains the load data or statistics that you want
to report, analyze, etc. The Load Data Analysis programs in Oracle Utilities
Load Analysis work primarily with the ELDB (Extracted Load Database).
The ELDB typically contains load data that has been checked for
completeness and reliability, and is considered ready for analysis. You may
have multiple ELDBs for different departments and/or applications. The
Load Data Management programs work primarily with the CLDB (Current
Load Database), which contains customer load data that is in the process of
being verified. The ALDB and SLDB are archived subsets of the CLDB
and ELDB, respectively. The GLDB and RLDB are utilized by the Cost of
Service Interface System (COSI) optional extension to Oracle Utilities Load
Analysis. For more information, see the Cost of Service Interface (Electric) User’s
Guide.

Common Files: a set of files that define various schedules applied by many
of the Oracle Ultilities L.oad Analysis analysis and reporting programs. Unlike
the Control and Environment files that you create for your own use and
store in your personal directories, the Common Files reflect the policies of
your facility and are generally used by all Oracle Ultilities Load Analysis users.
For that reason, they are seldom modified. They are:

*Holiday File - a list of all national and local holidays observed in your service
territory.

* Time-Of-Use Schedule File - a schedule of on-peak, off-peak, and shoulder
periods.

*Season File - a schedule applying different TOU schedules to seasons
throughout the year.

*Demand Period File - a schedule of “on-demand” periods.

* User-Specified Day File - a schedule of user-defined days to be averaged
together in an analysis.

*Billing Cycle File - a schedule of billing cycles for the Billed Energy program.

*Peak Days File - a schedule of Peak Days for the Daytype Analysis program.

See the Oracle Utilities Ioad Analysis Introductory Guides, Volumes I and II, for more
details.
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Running a Procedure
1. Once you have completed your selections for inputs and outputs, click the Submit button.
The Job Parameters window appears.
2. Complete the Job Parameters window as desired:

*  Job Name: This is automatically supplied (the program name plus a sequential number),
but you can change it as desired.

The maximum number of characters allowed for job names is 40.

Note: The hh:mm you specify for *  Start Date and Time: Optional. Specify a date and time here if you don’t want to run the
the time should be in the 24-hout,

program immediately. This will cause the execution of the program to be placed in a
military time format.

queue. The queue can hold up to 100 jobs.

*  Optional Command File: Leave this blank when submitting a standard Oracle Utilities
Load Analysis job. Enter the name of a custom Command File when submitting a
custom job.
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When you click OK, the job begins running which you can see in the Queue panel at the
bottom of the screen.

The Queue panel displays the status of all pending Oracle Ultilities L.oad Analysis jobs.
Depending upon how the System Administrator has configured the system, you may see all
jobs that are waiting in the queue, or just those that belong to you. The list in the window is
automatically updated by default every eight seconds. When a job has completed successfully,
the system marks it Done and, a few seconds later, clears it from the screen if auto clear is
selected in the setup screen.

Cancel Job button: To cancel a job, highlight its entry in the Queue panel and click the
Cancel Job button.

Refresh button: To refresh all jobs from the Queue panel, click the Refresh Jobs button.
Clear Queue button: To clear all jobs from the Queue panel, click the Clear Queue button.

Results button: To refresh all jobs in the Results panel, click the Results button.

About Status messages: Status messages in the Queue panel follow this format:

for completed jobs only

'jobname=condition-code"(elapsed time) !

userid.jobname - status:

Example:
UID.Y3104079 - Done: 'UID.Y3104079=99'(0 min, 5 sec)

*  Userid: Your network logon ID.
* Jobname:Name you or the system assigned in the Job Parameters window.

*  Starus: Current status and, if the job is waiting in the queue, its Oracle Ultilities Load
Analysis program ID and the time that it’s scheduled to run.

*  Condition code: Condition codes tell you whether or not the job completed
successfully. A “0” code means successful completion. A condition code of anything
other than 0 may indicate a problem. A “99” code, for example, means that Oracle
Utilities Load Analysis detected an error, possibly in your Environment File or Control
File, and that the job terminated abnormally. If you see a condition code of anything
other than 0, be sure to check the output reports for error messages (see next
section).

*  Elapsed time: Time between the start of the job and its completion.
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Viewing and Managing Job Results

Viewing and Managing Job Results

How to View and Edit Results:

3-8 Load Analysis User’s Guide

1. To view the results of a completed job, click within Results panel on the right of the screen.

Results
----- £ Q9410005 -
----- ) Q9420000

..... o Q 002

----- ) Q9420024

----- ) scan_archive_del

----- ) Sum Rep with only TR data

----- ) Sum_Rep_with_only_TR_data2

----- ) Training_CLDB

----- ) Training_CLDB_INP_lImpart

----- ) Training_ELDB

----- ) Training_ELDB_INP_Import —
----- ) X1110006

----- ) X1110013

----- ) X1110014 |

2. Highlight the desired job directory in the Results list.

A list of files for the selected job appears in the panel below.

You can delete, copy, and move job directories by selecting a job and clicking the right mouse
button.

To delete a job directory, select Delete.

To move a job directory, select Move and select the destination to which you wish to
move the directory.

To copy a job directory, select Copy and select the destination to which you wish to copy
the directory.

3. Select the file you wish to view.

The following types of files are generally produced at the end of a successful job run:

cslstar.job: list of Environment File variables used and their values.

dbparms.inf: database connection information. Listed only when working with data
stored in relational tables

sysprint.htm: text file containing all reports produced by the job run. Oracle Ultilities
Load Analysis automatically places a useful report index at the end of this file.

Note: Programs D110, D111, X110, and X111 include a “Combine Reports” checkbox
that if checked (default) combines all reports at the end of the job (as in previous
versions). If this option is disabled (unchecked), the reports are output separately. The
names of the separated reports will follow the naming convention described below:

<ProgramID>Sysprint<n>.rep when multiple runs of the same program are invoked

For example, CLDB Production input (X111) with Auto Editor engaged will produce
the following reports:

*X111Sysprint.htm - This will be the Direct Input program report. (May be D111)
*X210Sysprint]l.htm - This will be the initial Validation Report.
*X310Sysprint.htm - This is the Editor Report.

*X210Sysprint2.htm - This is the validation report of the cuts that have been edited.



Viewing and Managing Job Results

*X410Sysprint.htm - This is the reporter step for the cuts that did not pass validation.

sysprint.htm: an html file containing all reports produced by the job run. Oracle
Utilities Load Analysis automatically places a useful report index at the end of this file.

See Viewing the SYSPRINT.HTM and SYSGRAPH.HTM Files on page 3-12 for
more information about viewing this file.

sysgraph.htm: an html file that allows users to view graphs of the cuts produced by the
job run. See Viewing the SYSPRINT.HTM and SYSGRAPH.HTM Files on page
3-12 for more information about viewing this file.

(name).dat: file containing data generated by the program, such as individual customer
statistics.

run.log: text file of information about the job run, such as processing time. This is
useful for diagnostic purposes if there is a problem with the run.

<FILE_NAME>.XML (Key Generator only): XML file containing results of a key
generator query, where <FILE_ NAME> is the name of the Output Keys File specified
on the Key Generator Submit screen. See Creating XML Control File Query Lists on
page 13-39 in Oracle Utilities Load Analysis L.oad Data Management Uset’s Guide for
more information about creating XML output from the Key Generator.

Note: The control file composer for the Key Generator will allow mixed-case
to support XML.

In addition, Oracle Ultilities Load Analysis puts a copy of your input files in the job directory.

Select a tool for viewing or editing the highlighted file. The Results window gives you access

to several tools for viewing and manipulating the contents of a selected file:

Right Click Options: In addition, you can click the right mouse button and select from
a number of options, including:

*  Copy: Allows copying the file to another directory. See Copying Results to
Another Directory on page 3-10 for more information.

*  Delete: Allows you to delete the selected file.
*  Rename: Allows you to rename the selected file.

* Load XML as List: Loads XML output created by the Key Generator as a list in
the CLSLSLISTS.MDB database. Once loaded, XML lists can be used when
creating control files.

*  Email: Allows you email the selected file(s). If you select more than one file, the
selected files can be compressed in a .ZIP file for emailing. See Emailing Files on
page 3-11 for more information.

*  Open With: Allows you to open the selected file with the Default Viewer, Alternate
Viewer or an Associated Program (defined on the Configuration tab of the Setup
dialog).

*  Show System Files: Allows you to view the system files such as *.log and *.CFG
that are listed above under item 3.

Working with Jobs 3-9



Viewing and Managing Job Results

Copying Results to Another Directory

You can copy any of your job results files to desired directories without having to leave the
Results window.

How to Copy Results:
1. In the Results window, highlight the job file you wish to copy.

2. With your cursor in the Job Files List window, click the 7gh? mouse button, then select Copy
from the drop-down list that appears. Select from the following options:

*  Copy to Production Input Directory: Copies the selected file to the
\COMMON\LOAD directory.

*  Copy to Common Files Directory: Copies the selected file to the
\COMMONN\DATA ditectory.

*  Copy to Client Data Directory: Copies the selected file to the DATA directory on your
local hard drive.

*  Copy to Anywhere: Copies the file to a directory you specify.
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Emailing Files

It is also possible to compress and email files from the Results window using Microsoft Outlook
or Lotus Notes. To enable this option, include the following settings in the CSLS_91.INI file:

Note: Microsoft Outlook 2000 is not supported.

EmailEnabled: Designates that emailing of results files is enabled (YES or NO). The default
is NO.

EmailSubject: Specifies the default subject line for emails sent from Oracle Utilities Load
Analysis.

EmailServerType: The email server type used. Can be either “OutLook” or “Lotus Notes”.

EmailedZipFileName: Enables compression of files into a .ZIP file, and specifies the name
of the ZIP file created. The default is “LoadAnalysisResults.”

DominoPassword: The password used to connect to the Domino server.
DominoMailDatabase: The Lotus Notes database from which the mail is sent.

DominoServer: The name of the Domino server.

Example: The following settings allow results files to be emailed via the Outlook email client.
The default subject for the email is “Oracle Utilities Load Analysis Report.” If multiple files are
selected, they would be attached as individual files.

EmailEnabled=YES
EmailServerType=OutLook
EmailSubject=Load Analysis Report

EmailedZipFileName=LoadAnalysisResults

How to email a report:

1.
2.

Select the report(s) you wish to email and click the right mouse button.

A new untitled message will open in your email application. The selected file(s) will be
included as an attachment(s) in the message.

To compressed multiple attachments into a single ZIP file, select Shift-F1 and the files will be
compressed into a ZIP file and attached to the email.

Complete the email (address, subject, body text, etc.). When using Lotus Notes to send email,
the program prompts the user for the recipient’s address and sends the email with the default
subject and no message text.

Renaming Results Files

It is also possible to assign a new name to a file. Highlight the desired file under Job Files in the
Results window. Click the 7igh# mouse button, then select Rename from the drop-down list that
appeatrs.
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Viewing the SYSPRINT.HTM and SYSGRAPH.HTM Files

The SYSPRINT.HTM file is an HTML file that allows users to view the SYSPRINT reports in a
web-browser such as Microsoft Internet Explorer. The SYSGRAPH.HTM file is an HTML file
that allows users to view graphs of the cuts produced by the job run in a web browser such as
Microsoft Internet Explorer.

Viewing the SYSPRINT.HTM File
To view the SYSPRINT.HTM file in Internet Explorer, select the SYSPRINT.HTM file, click the
right mouse button and select Open With-»>Associated Program or double click on it if Internet
Explorer is your default browser. The file opens in an Internet Explorer window.

Note: There is a setting in the Tools tab of the Setup window which warns
users if they are about to view a report that is very large, since if a report
exceeds memory limitations it can cause the browser to freeze. The defaultis 10
MB and a popup a message will appear allowing the user to cancel the load if
the file is larger than the preset limit.

The sysprint report is broken down into two sections, the Report Index and Options panel, and
the Report Content panel.

The Report Index is a navigational tool containing an index of all the available sections in the
SYSPRINT report. The Report Index lists the sections of the report. To navigate to a section of
the report, select the desired section from the Report Index. The selected section of the report
window will appear in the Report Content panel.

The Options button the user to configure the default viewing and printing behaviors. To set
report options for this and other SYSPRINT.HTM reports click Options. The Report Options
dialog opens.

*  View Font Style: To set the default font for SYSPRINT.HTM reports, select the desired
font from the drop-down list. The default font is Lucinda Console.

*  View Font Size: To set the default text size for SYSPRINT.HTM reports, select the
desired font size from drop-down list. The default font size is 8 pt.

*  View Font Color: To set the default text color for SYSPRINT.HTM reports, select the
desired color from drop-down list. The default font color is Navy.

*  Print Font Style: To set the default font used for printing reports, select the desired font
from the drop-down list. The default font for printing is Lucinda Console.

*  Print Font Size: To set the default text size for printing reports, select the desired font
size from drop-down list. The default font size for printing is 6 pt.

*  Click OK to save your settings. Click Reset to restore the settings to their previous
values.

3-12 Load Analysis User’'s Guide



Viewing and Managing Job Results

Viewing the SYSGRAPH.HTM File
To view the SYSGRAPH.HTM file in Internet Explorer, select the SYSGRAPH.HTM file, click
the right mouse button and select Open With-»Associated Program or double click on it if
Internet Explorer is your default browser. The file opens in an Internet Explorer window.

The window displays a list of cuts produced by the job run. For each cut the window displays the
following:

Number: The number of the cut. This is used for informational purposes on this screen
only.

Graph? (checkbox): A checkbox that indicates if the cut should be included in the graph
display.

Recorder ID: The recorder ID of the cut.
Chan.: The channel number of the cut.

Start: The start time of the cut.

Stop: The stop time of the cut.

SPI: The seconds-per-interval (SPI) of the cut.
UOM: The unit-of-measure (UOM) of the cut.
Total: The total of the interval values in the cut.

Plot Type: The plot type for graphs for the cut. There are two options: Time Series and
Duration.

*  Time Series: The X-axis displays the Start Time through the Stop Time of the cut.

*  Duration: The cut’s intervals are sorted in descending order and the X-axis is based on
the interval count starting from 1 through the last interval in the cut.

Note: When plotting graphs in combined graph mode (overlay or stack), all cuts must be
designated with the same plot type.

Color: The custom color associated with the cut. This column only appears if the Custom
option is selected from the Color drop-down list. To select the custom color for the cut, click
the colored square and select the desired color from the dialog,

The Graphing Toolbar
The graphing toolbar contains the following:

Display Graph | Cuts: Toggles switching of the current view between displaying graph view or

displaying cuts view. Note that at least 1 cut must be selected in order to display graph.

Options: Opens the graphing options dialog, containing the following graphing options:

Y-Axis Max Value/Y-Axis Min Value: The graph will be scaled to the provided Y-Axis
Max Value and Y-Axis Min Value. The values will be ignored if the Max and Min in the
actual data contain values greater than or lesser than those provided. The default value is
“auto”, which means the Y-Axis scale will be based on the data.

Y-Axis Precision: Controls the number of significant digits of the Y-Axis labels. The default
is 4.

Major Tick Marks: To set the default number of major tick marks along the X-axis for
SYSGRAPH.HTM graphs, select the desited number from the Major Tick Marks drop-
down list.

Minor Tick Marks: To set the default number of minor tick marks along the X-axis for
SYSGRAPH.HTM graphs, select the desited number from the Minor Tick Marks drop-
down list.
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*  Highlight Status Color: To set the default color for highlighting status codes in
SYSGRAPH.HTM graphs, select the desired color from the Highlight Status Color drop-
down list.

Note: If you select Custom here, the Color column appears on the Cut screen.

¢ Default Color: To set a default custom colot, click the Custom Default Color colored
square and select the desired color from the dialog;

*  Horizontal Grid Lines: To set a horizontal grid line at a specified value, enter that value in
the Custom Grid Lines box. For example, custom grid line can be set at 0 for better
visualization of the positive and negative values on the graph. Grid lines will not be drawn if
the provided vale is outside the scope of the graph.

*  Title: For Single and Stack graphs (see below), you can specify a default title for graphs by
entering the title in the Graph Title box. Note that this option is not available for Individual
graphs.

*  Click OK to save your settings. Click Reset to restore the settings to their previous values.
Graph Type: Select the type of graph to display. There are three graph types:

*  Individual: Displays each graphed cut as a separate graph.

*  Single: Displays each graphed cut on the same graph, with each cut overlaying each other.

*  Stack: Displays each graphed cut on the same graph, with each cut stacked one on top each
other.

Size: Set the default graphing size (auto, 50%, 100%, 125%). Select the desired size from the
Graph Size drop-down list. If auto (default) is selected, the size of the graph is determined by the
cut.

Color: The colors of the lines on the graph can be either set automatically or be customized. To
specify which setting you prefer, select the desired setting (auto or manual) from the Colors drop-
down list.

Highlight Status Codes: To highlight status codes in the graph(s), select the desired comparison
("None", "Equal To", or "Worse Than or Equal To") from the Highlight Status Codes drop-down
list, and the specific status code from the status code drop-down list.

Viewing Graphs
To view a graph of one or more of the listed cuts, check the checkbox that corresponds to the
cut(s) you wish to view and click the Graph button. The selected cuts appear on a graph in the
window.

Note: For Single and Stack graphs, all selected cuts must have the same SPI value.
The graph displays the following information:
*  Title: The title of the graph. Note that this does NOT appear for Individual graphs.

*  CUST ID: The recorder ID and channel number of the cut. Appears ONLY on Individual
graphs.

*  Start-Stop: The start time and stop time of the cut(s). If these values differ between cuts, the
eatliest Start Time and the latest Stop Time are displayed.

*  UOM: The unit-of-measure (UOM) of the cut(s).
*  Legend: For Single and Stack graphs, a legend also appears below the graph.

To return to the Cuts screen, click Cuts.
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Deleting Results

Oracle Ultilities Load Analysis saves the results of each program that you run in a sepatate job
directory on the server. Periodically, you should delete unwanted directories and files.

How to Delete Job Directories:

1.

At the Oracle Utilities Load Analysis screen, click within Results panel area and highlight the
desired job directory, then right-click and select Delete. If you wish to delete a number of
directories at once, highlight each one while holding down the SHIFT key on your keyboard,
then click Delete. Instead of clicking Delete, you can press the DELETE key on your
keyboard.

A box appears asking you to verify that you really wish to make the deletions.

Respond to the question as desired. If you click Yes, the directory and all of its contents are
deleted.

You can also delete selected files within a job directory.

How to Delete Job Files:

1.

In the Results panel highlight the job directory containing the file you wish to remove. Then,
highlight the file in the Job Files list.

Click the right mouse button, then select Delete from the drop-down list that appeats.
Respond to the warning as desired.
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Chapter Four

Working with Input Files

This chapter explains how to create and modify Environment, Control, and Common files using
Oracle Utilities Load Analysis’s File Composer. It also describes how to manage “type
information” — an important link between programs and the input files you’ve created to use
with them.
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Overview

File Composer

File Types

Here is a brief explanation of the Oracle Utilities Load Analysis features and functions covered in
this chapter.

The File Composer is a “smart editor” that guides you through the process of creating, editing,
and saving Environment and Control files. It is especially useful for working with Environment
files, since it automatically displays the appropriate command and parameter options for each type
of file.

“Type” is an important file management concept in Oracle Utilities Load Analysis. A file’s type
identifies the program that the Environment File or Control File works with. For example, an
Environment File might be typed to work with the 100% Sample Analysis Program. In other
words, type is an internal association between an input file and a program. Types are useful
because they make it possible for Oracle Utilities Load Analysis to automatically display only those
files or file options that are appropriate to the program you’re using.

Graphical Key Generator
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The Graphical Key Generator is used for creating or editing Simple Key Generator Control files.



Overview

Common Files

The term “Common Files” refers to the Holiday File, Time-Of-Use Schedule File, Season File,
Demand Period File, Billing Cycle File, Peak Days File, and User-Specified Day File. Typically,
Common files are established according to the policies of your facility, and are used by all Oracle
Utilities Load Analysis users. For that reason, they are typically stored on the server, rather than
your local drive. You should not modify these files except under special circumstances. Occasionally, you may
want to try out “What If” scenarios using test versions of the Common files. In that case, it is
recommended that you save the experimental versions with meaningful names that are easily
recognized by you and by other users.

You’ll find a description of the commands that make up the Common files in the Oracle Utilities
Load Analysis Load Data Analysis Users Guide.
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Creating and Editing Environment and Control Files

You can use the File Composer to create Environment or Control files, or to edit existing files.

Using the File Composer
How to Launch the File Composer:

1. You can also open the File Composer by clicking the New or Edit button on a Submit
Panel.

Submit [#]

Ll

2. Compose the Environment File or Control File as desired.

See Creating an Environment File on page 4-5 for instructions for creating an
Environment File. See Creating a Control File on page 4-5 for instructions for creating a
Control File.

Note: The composer window includes two column number and row number
indicators on the bottom of the screen, in order to indicate how many
characters have already been typed. This is helpful since there is a line size
character limit.

Composer Tools
The Composer window displays six buttons along the top of the text box to help when creating
files:

*  Sort: sorts the settings in the file alphabetically

*  Clean: reformats the settings in the file, cleaning and removing up any extra blank spaces in
commands

*  Sum: sums the value of a specified field
*  Group: removes duplicate settings from the file
*  Comment: comments out the selected settings

*  Uncomment: uncomments the selected settings

Entering Commands in the Composer
There are four methods for using the File Composer, which can be used interchangeably:

Note: Tab characters are not *  Using your keyboard, you can simply type your entries in the left list box. You can edit text in
allowed in Control, Environment, the left list box using standard text editing techniques and the Edit controls (Cut, Paste,
and other input files. Copy, and Undo)

, .

*  Select a command or parameter from the pane on the right and click Paste.
*  Double-click a command or parameter in the pane on the right.

*  Right-click in the pane on the left and select a command or parameter from the pop-up menu
that appears. Note: This option is only available if the Right Mouse Button Behavior
option is set to Composer on the Tools tab of the Setup dialog,
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Creating an Environment File

All of the commands that pertain to the specified type of file appear in the File Composer’s right
list box. As you create your file by selecting commands and parameters, they appear in the left list
box.

You can find detailed descriptions of the commands and parameters that make up a particular type
of file by referring to the appropriate Oracle Utilities LLoad Analysis manual (see Appendix A:
Programs Available via Oracle Utilities Load Analysis). You can select commands in the right
list box in any order, but be sure to select all that are required (the system will not automatically
alert you if you leave something out).

How to Create an Environment File:

1. Select a command from the list box on the right side of the File Composet, using one of the
four methods desctibed under Creating and Editing Environment and Control Files on
page 4-4.

The first three letters of the command will appear in the left pane.

2. Specify parameters, using one of the four methods described under Creating and Editing
Environment and Control Files on page 4-4.

Note: In some cases, a parameter shown in the list on the right is merely a placeholder to
remind you of a parametet’s format. For instance, the parameter mmddyyhhmmss stands
for the date and time. When you paste the parameter into the left pane, you will then need to
highlight and edit it. For example, 060195000000.

The selected parameter(s) will appear in the left pane, following the command selected in

Step 1.
3. Click Next to specify another command (repeat steps 1 and 2), as needed.

4. When you have completed the file as desired, click Close or Save, then name and save the
file.

Give your file a unique, useful name (up to 105 characters long, including spaces). You do not
need to include the 3-letter file name extensions. Oracle Utilities Load Analysis supplies the
file extensions by default.

Also, save the file in the default directory, shown in the dialog box just under Directories. In
the illustration above, it’s c:\cslstar\data. (For Control and Environment files, the default
directory is defined in the File Paths tab under Tools->Options.) Otherwise, the file won’t be
available for the Submit Panel (see Chapter Three: Working with Jobs).

Creating a Control File

You create the Control File by typing text into the text box. You can apply any of the Edit
controls (Cut, Copy, Paste, and Undo).

Templates: Templates are “master” Control and Environment files that you can use as a starting
point for your own versions. Working from a template saves you the effort of typing an entire new
file. All Control and Environment files have appropriate templates.

Note: All template files must reside Oracle Corporation delivers a set of templates with the Oracle Utilities L.oad Analysis software (a
in the server Common\Data list is provided in Appendix C: Oracle Utilities-Supplied Input Files). Oracle Utilities Load

folder and have a file extension of

»

Analysis recognizes the templates by file name. The convention is TGXxxA for Control files and
TGXxxB for Environment files, where Xxx is the program identifier (for example, TGY22A is
the Control File for the program Y220, Manual Entry). If your facility wants to use a different file

«

tem’

for a template, you must give it the file name specified in Appendix C: Oracle Utilities-Supplied
Input Files. Otherwise, the file will not appear when you click the Template button.

When you have completed the file as desired, click Close or Save, then name and save the file.
Also, save the file in the default directory, shown in the dialog box just under Directories. (For
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Control and Environment files, the default directory is defined in the File Paths tab under Tools-
»Options.) Otherwise, the file won’t be available for the Submit Panel (see Chapter Three:
Working with Jobs).

Using Key Generator Lists
The Key Generator can create lists in XML format that can be used when creating control files.
See Creating XML Control File Query Lists on page 13-39 in Oracle Utilities Load Analysis
Load Data Management User’s Guide for more information about creating XML output from the
Key Generator.

Note: The control file composer for the Key Generator will allow mixed-case
to support XML.

How to select values from a Key Generator list:

1. Click List button on the File Composer. The Defined Lists window opens.

2. Select the Key Generator list from which you wish to select the value from the Your Defined
Lists drop-down list. Only lists created with your User ID or a User ID of “PUBLIC” are
displayed. The selected listed appears in the window.

3. To add values from the displayed list to the control file, do the following:
a.  Select the appropriate record from the record list. To select all records, click Select All

b.  Select the column that corresponds to the value you wish to select in the Columns to
insert list. To select multiple columns, hold down the Cttl key and select multiple items.
The CUSTID and CHANNEL columns are selected by default.

c. Click Insert. The values from the selected records/columns are inserted into the control
file.

d. Click Close to close the Defined Lists window.
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Including Comments in Control and Environment Files

Comments can be included in Control and Environment files and may appear anywhere a blank is

valid.

Most comments are stripped out of the Control and Environment files and replaced with a blank
before being processed by programs. However, a comment that is contained within a quoted
string will be retained.

The following rules apply when including comments:

1. All comments must begin with slash-asterisk (/*) and end with either asterisk-slash (*/) ot
the end of the line. The comment-ending asterisk-slash symbols are therefore optional and
comments may not extend across lines.

2. A comment that is totally contained within either single quotes or double quotes (including its
initial slash-asterisk and terminating asterisk-slash if present) will be left as it is, i.e., the

comment will remain in the file.

3. Any comments not totally contained within quotes will be replaced by a single blank.

4. Any line containing nothing but comments will be deleted.

5. Input files to programs that can read comments will not have the comments removed. These
include the following:

Transfer Type Utility

Key Generator: G810, X810, X820, Y810, Y820
Transformation: X620, Y620

Invalid Series Validation: X220

Customer Data Extraction: Y110

Sampling control files that use our user language

Oracle Utilities Load Analysis Type Transfer Utility, used for convert multi-typed information
from one CSLSINFO.MDB to another.

You can run the Type Transfer Utility by selecting the File-»>Type Transfer Utility menu.

1. When the window appears you can browse for the CSLSINFO.MDB file in the Select Info
Database (CSLSINFO.MDB) to Import: field.

2. Then select Browse for Location of CTL and ENYV files to Import.
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Chapter Five

Managing Data

This chapter provides some helpful tips for managing your interval data records and statistics
records (both called “cuts”). Specifically, it introduces the three programs that are available for
getting cuts into the interval databases, where you can apply the Oracle Utilities Load Analysis
programs to them. The chapter then explains how you can delete cuts from a Oracle Utilities Load
Analysis database, and how to move or copy cuts from one database to another.
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Getting Data into the Interval Databases

The CLDB (Cutrent Load Database) and the ELDB (Extracted Load Database) are the
“working” interval databases for the Oracle Utilities Load Analysis L.oad Data Management and
Analysis programs, respectively. That is, the data that you want to work with must be in one of
these databases. You may actually have a number of CLDBs and ELDBs, depending upon the

Input Programs
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needs and policies of your facility.

In the Client/Server version of Oracle Utlities Load Analysis, the CLDB and ELDB are either
Pervasive databases that reside on the server, or tables in the Oracle Ultilities Data Repository.

In Oracle Utilities Load Analysis, four programs are available for getting data into an interval

database. Which program you use is determined by where the data comes from:

Direct Input (D110, X110, E130, Y130): This program is used to input a relatively small file
of interval data. D110 and E130 are for .INP format; X110 and Y130 are for .LSE format.
The file must be in the Direct Input format, and it must reside on your local drive. You’ll find
instructions for using Direct Input in the Oracle Ultilities L.oad Analysis Load Data Uset’s
Guides.

Production Input (D111, X111, E131, Y131): Used to input large amounts of interval data
from a translator into the database on a regular, “production” basis. D111 and E131 are for
INP format; X111 and Y131 are for .LSE format. The only difference between Direct Input
and Production Input is the location of the interval data input files. The Production Input
files must reside on a network server. Because these files are usually very large and require a
long time to process, you would typically schedule them to run at night or during another off-
period.

Manual Entry (X120, Y220): Used to input a small, manually-created file that is available on
your local data directory.

Move/Copy/Delete (Q91M, Q91C, Q91D): Used to delete cuts, or to move ot copy cuts
from one Oracle Utilities Load Analysis database to another. This program applies just to

Oracle Utilities Load Analysis databases; that is, those that reside on a server and are in the
Pervasive format. You’ll find instructions for using these programs on the following pages.
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Moving, Copying, and Deleting Cuts

The remainder of this chapter explains how to delete cuts from a database, and how to move or
copy cuts from one database to another.

1. Select a program category from the categories displayed along the left side of the screen.

2. Select a program from the program names displayed below each category.
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Your selections depend upon which operation you wish to perform:

To do this: Select....
Category Program
Move cut(s) from one database to  Administrator Move Cuts

another, deleting the original(s)

Copy cut(s) from one database to  Retrieval Copy Cuts
another, leaving the original(s)

intact

Delete cut(s) from a database Editing Delete Cuts

3. Specify a Control File.

The Control File is a list of the cuts that you want to move, copy, or delete. The cuts may be
interval data records or statistics records.

You can use an existing Control File as-is or with modifications, or you can create a new one
from scratch using the Oracle Utilities Load Analysis File Composer (described in Chapter
Four: Working with Input Files), or the Key Generators. In any case, the file must conform
to the format specifications below.

Note: Bach program run will Control File Format: For each cut that you want to move, copy, or delete, you must specify
perform just one operation (Move, its f”// key, as shown below.

Copy, or Delete) on all valid keys

in the file.

customer-id, channel-number, start-time

The start-time for interval data records must be formatted as follows:
mm/dd/yy-hh:mm:ss or mmddyyhhmmss.

Delimiters (separators between the parts of the cut key) may be commas (as shown above) or
blanks.

You can have an unlimited number of cut keys in your Control File.

Examples: The sample Control File shown below identifies five interval data records:

N1723,1,06/01/95-00:01:00
N1723,2,06/01/95-00:01:00
N1727,1,06/01/95-00:01:00
N1743,1,07/01/95-10:57:00
N1754,1,07/04/95-11:30:00

The next sample Control File identifies five statistics records:

RESI-NCD-SMEN, 0,05/01/95-00:01:00
RESI-NGY-SMEN, 0,05/01/95-00:01:00
RESI-LFC-SMEN, 0,05/01/95-00:01:00
RESI-LFN-SMEN, 0,05/01/95-00:01:00
RESI-DF-SMEN, 0,05/01/95-00:01:00

4. Specify an Environment File.

The Environment File describes how you want the cuts to be processed. You can specify an
existing Environment File, or you can use the File Composer to create a new one or modify
an old one.

Environment File Format: The commands and their parameters that make up the
Environment File are shown in the box below. Only the three letters shown in capitals are
required (for example, RPL). You can enter commands and parameters in upper and/or lower
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case; the system will automatically force all letters to upper case. You must put each command
on its own line in the file.

RPL

REPort [ALL | EXCeptions ]
KEYlist

ALL

*  RPL: (Optional, may be used with Move Cuts or Copy Cuts) If a cut with the same key
already exists in the target database, the program replaces the existing cut with the new
one. Note: This operation replaces an existing cut’s edit trails, too. So, if for some reason
you need to recover an old cut after applying the Move Cuts or Copy Cuts program,
you’ll need to get it from a recent backup of the original database.

The default for Move or Copy is to not replace an existing cut; that is, the existing cut is
left as-is, and the new cut is not entered into the database.

*  REPort: Specifies the contents of the Execution Log produced at the end of the
program run. REP ALL reports the status of all keys listed in the Control File. With
REP EXC, only the cuts that failed the operation are listed. REP ALL is the default. In
either case, the Summary Report produced at the end of the program run will indicate
the total number of keys processed.

*  KEYlist: (Optional) Produces an output file of any keys from the Control File that the
program could not find in the database.

*  ALL: (Optional) Copies all cuts from one database to another without the need of a
Control File.

Notes: ALL will be valid only with the COPy function. If coded in conjunction with
either MOVe or DELete the program will issue an error message and terminate.

When the COPy function is run with ALL, any Control File supplied will be ignored.

Upon a successful run of COPy ALL, separate counts of the number of cuts, archive
cuts and edit trails copied will be displayed.

5. Specify the remaining inputs and outputs.
6. Complete the Job Parameters window.

See Running a Procedure on page 3-6 if you need additional instructions.
7. View the results.

In the job directory produced by the program, you will find a Sysprint File and (optionally) a
Keylist File. (See Viewing and Managing Job Results on page 3-8 for instructions on how
to locate and open the job directory.)

The Sysprint File consists of reports that let you know whether or not the job processed
successfully. Be sure to check these reports carefully:

*  Environment Report: lists back the commands from the Environment File.

*  Execution Log: reports the status of each cut in the Control File (i.e., whether or not
the operation was successful, per cut). If you specified REP EXC in the Environment
File, the report includes only cuts that were not successfully processed.

*  Summary Report: contains useful statistics about the job; how many cuts were
processed, how many cuts were successfully processed, and how many cuts were
unsuccessful.

Important Note: If you are copying or moving cuts from a CLDB or ALDB into an ELDB or
SLDB, all edit trails and archives will be removed. In addition to this, the edited flag will be
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changed to an “N” from a “Y”". This is due to the requirement that ELDBs must not contain audit
or edit information. Additionally, the following keywords apply DBA ELDB (Target database) and
DBA CLDB for the (Source Database).
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Chapter Six

Overview

The Program Sequencer

This chapter explains how to define and run a customized sequence of Oracle Utilities and non-
Oracle Ultilities programs.

The Program Sequencer lets you “chain” together a series of Oracle Utilities Load Analysis, user-
written, and/or third party executable programs in a customized sequence. It lets you specify — in
one concise Command File — instructions for executing up to 99 programs in a single job stream,
including the sequence of the programs, the desired inputs for each, and the destination directory
and databases for the results.

Once you have defined the sequence, you can apply the Windows Schedule Service to have it
process unattended in batch mode—automatically without additional user intervention. You could
schedule it to run automatically at one future date and time, or you could schedule it for repeated
periodic execution. For example, you might create a sequence that automatically backs up,
compresses, and generates summary reports on a selected database every Wednesday and Friday at
1:00 am.

You can also submit the sequence for immediate processing using the Oracle Utilities Load
Analysis Graphical User Interface.

This chapter explains how to define a program sequence and its inputs, and how to submit the job
in interactive or batch mode.

Note: You cannot use the Sequencer for Sampling programs.
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uencer-Related Files

Establishing Directories for Sequencer-Related Files

Note: The path names are written
as the Server machine sees them,
not as the Client machine sees
them.
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As you will see in the following pages, you define a sequence of programs and their inputs in a
Command File called a “SEQ” File (named after the ‘.seq’ extension that identifies this type of file
to the system).

The Sequencer can access input files required by the program being run in one of two ways; by
searching the SEQINPFILS location (described below), or by having a full path and filename
specified in the Sequencer Setup (SEQ) File. In other wotds, if no path is specified in the SEQ
File, the Sequencer will search the location specified by the SEQINPFILS setting in your
CSLSTAR.GLB File for the input files specified in the SEQ File.

In batch mode, the Sequencer can accept a full path and filename to the SEQ File, so the
Sequence files do not have to reside in the location specified by the SEQUENCERFILES setting
in your CSLSTAR.GLB File.

Important: When executing the job through the Graphical User Interface, however, it is
necessary for the SEQ files to be in the location specified by the SEQUENCERFILES setting (as
described below).

As part of the Oracle Utilities Load Analysis system installation, you or your System Administrator
must establish two directories for Sequencer-related files. The first directory holds your SEQ files;
the second holds all input files specified in those SEQ files. The directories can have any name,
and be located anywhere on a local or network drive accessible by both the client and the server.

So that the Sequencer can find the directories you’ve created for this purpose, the CSLSTAR.GLB
Configuration File must contain the following two lines:

SEQUENCERFILES <full-path-name>

where <full-path-name> is the path to the directory that holds the SEQ files; for example
SEQUENCERFILES e:\CSLSTAR\SETUPFLS\.

SEQINPFILS <full-path-name>

where <full-path-name> is the path to the directory that holds the input files; for example SEQINPFILS
e\CSLSTAR\INPTFLS\.

The backslash (\) at the end of each line is required.
How to Modify CSLSTAR.GLB:

1. Select File->PC Server Configuration->Run Time.
The Server Configuration window opens.

2. If an entry for SEQUENCERFILES already exists, highlight the line. (If not, type
SEQUENCERFILES in the Keyword box.)

3. In the Value text box, type the full path to the directory set up to hold the SEQ files.
4. Click Add or Replace.

5. Update or add the SEQINPFILS line with the path to the directory for the input files, using
the same method.

6. Click Save to save your changes to the CSLSTAR.GLB File and close the dialog box.

Note: If you later change the name or location of either directory, you must update the
CSLSTAR.GLB File accordingly.
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Creating a SEQ File

Important! 1f used, this record must
be the first record in the SEQ File.

The first step in taking advantage of the Program Sequencer is to create your SEQ File. The SEQ
is a simple text file made up of a series of commands that tell the Sequencer what programs you
want to run, where to find and/or how to process the inputs required for each program, and
where to put the output.

You can create the file using Notepad or another text editor, or you can create it using the GUL
You must store the file in the directory that’s identified in the SEQUENCERFILES Command in

2

CSLSTAR.GLB (as explained on the previous page), and the filename extension must be “.seq”.

The following pages take you step-by-step through the process of creating a SEQ File. A
completed sample file is shown under Sample SEQ File on page 6-4. These instructions assume
that you have Notepad or another editor open.

Important: When specifying path names and/or file names that contain spaces,

<« 99

you must enclose the entire name in quotes (“ 7). For example,
OUTDIR “C:\CSLSTAR\OUTPUT AREA”
or
CTL “C:\CSLSTAR\DATA\CONTROL FILE.ctl”

How to Create a SEQ File:

1. Specify a directory to hold the output for sequences that you will submit in batch mode. The
directory specified must already exist. Oracle Utilities L.oad Analysis will not create it
automatically. If you will run this job using the GUI, this line is optional.

The first line in your SEQ File must specify the “Output Directory”, which is the parent directory that
will hold the subdirectories containing the job results.

The format of this command is:

OUTDIR <directory-name> [NoDateStamp]
where:

*  OUTDIR is a required keyword.

*  <directory-name> is the full pathname to a valid, ex/sting directory. Once the output
directory is specified, you can reference in later Step Definition record using the
“%JOBDIR%0’ variable.

*  NoDateStamp is an optional parameter that may be entered as either NoDateStamp or
NDS. Specifying this parameter causes the Sequencer to place the results directly in
<directory-name>. NoDateStamp is case-zzsensitive, and must be preceded by a space.

*  If the default Date Stamp feature is used, the <directory-name> you supply must
refer to a directory that already exists.

*  If the NoDateStamp option is specified, the <directory-name> you supply must
refer to a directory that does not exist. If you supply the name of an existing
directory with the NDS option, the job will end with a return code of 115.

Examples:

OUTDIR C:\CSLSTAR\SEQNCR

OUTDIR C:\CSLSTAR\SEQNCRD NDS

OUTDIR C:\CSLSTAR\SEQNCRD NoDateStamp

At the conclusion of a job run in batch mode, the Sequencer puts the results of the programs
in a subdirectory under the directory you specify here. The Sequencer names the subdirectory
using the year, date, and time of the run (according to the computer’s clock) in the
yyyymmddhhmmss format.
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If you submit the sequence via the Oracle Utilities Load Analysis Graphical User Interface and supply an
Output Directory Record, the results are output to the directory that you defined in the Output
Directory Record as described above.

W hether or not you supply an Output Directory Record, when you submit the sequence via the
Oracle Utilities Load Analysis GUI, the results are automatically placed in the job directory
that you specify when you submit the job. Under that directory, the Sequencer creates a
subdirectory for each job step, named using the convention STEP<step-number>.

Sample SEQ File
Sample SEQ File

1 Output Directory Command: 1 — OUTDIR C:\CSLSTAR\SEONCR
Tells the Sequencer where to put VALIDATIONENVFILE D:\CSLSTR\COMMON\DATA\TGD21B.ENV
the iob results. This is required if 2 ——| REPORTERENVFILE D:\CSLSTR\COMMON\DATA\TGD41B.ENV

J T q AUTOEDITENVFILE D:\CSLSTR\COMMON\DATA\TGD31B.ENV
you submit the program sequence 33—
in the batch mode, but optional if [~ # /* STEP 1: DIRECT INPUT OF DAILY SYSTEM LOAD AND MONITORED LOADS
you submit it via the GUIL CTL 120182.INP

ENV TGD11B.ENV

The di ified 4 — RUL TGD2IC.RUL RUN FILEPREP

€ directory specttied must DBA D:\CSLDBS\LPSSCLDB.BTE CLDB
already exist. Oracle Utilities Load DBA D:\CSLDBS\TSTAXDB.BTE AXDB
Analysis will not create it | APP D110

automatically.
# _/* STEP 2: VALIDATION
. . TL TGX112.DAT FROMSTEP 1
2 Default Environment File 5 ENV LPSX21B.ENV
commands: Tell the Sequencer RUL TGX21C.RUL RUN FILEPREP
DBA D:\CSLDBS\TSTAXDB.BTE AXDB
where to find the default DBA D:\CSLDBS\LPSSCLDB.BTE CLDB
Environment files required for APP X210
some steps. These commands are
required. # /* STEP 3: AUTO EDITOR
CTL TGX31AE.CTL FROMSTEP 2 OPTSKIPSTEP
. o ENV LPSX31B.ENV
3 A pound sign (#) indicates the DBA D:\CSLDBS\TSTAXDB.BTE AXDB
beginning of a Step Definition DBA D:\CSLDBS\LPSSCLDB.BTE CLDB
Record. APP X310

# /* STEP 4: DATA EXTRACTION TO PERFORM STATISTICAL EXPANSION OF SAMPLE POINTS

4 Step Definition Records: CTL Y240LPSS.CTL

Specify the procedure or program ENV TGY24B.ENV
to run, and any user-specified DBA D:\CSLDBS\LPSSCLDB.BTE CLDB
: : DBA D:\CSLDBS\LPSSELDB.BTE ELDB
inputs that are required for that AR TAl
procedure or program. SEQ files
CaﬂCOﬂﬁﬁﬂuptO99Swp& # /* STEP 5: STANDARD LOAD ANALYSIS RATE 1 GENERATING CLASS TEMPLATES
CTL Y31ALPSS.CTL

5 The Slash-Asterisk indicates the ENV' Y31BLESS . ENV

. DBA D:\CSLDBS\LPSSELDB.BTE CLDB
beginning of 2 Comment. DBA D:\CSLDBS\LPSSELDB.BTE CLDB2
Anything following the /* will be APP Y310

ignored by the program.
# /* STEP 6: STANDARD LOAD ANALYSIS RATE 2 GENERATING CLASS TEMPLATES
CTL Y31LPSS2.CTL

If you would like to number your ENV Y31LPS2.ENV

sequence steps you may do so DBA D:\CSLDBS\LPSSELDB.BTE CLDB

automatically by pressing together DBA D:\CSLDBS\LPSSELDB.BTE CLDB2

the CTL-ALT3 keys while in the APE Y310

sequencer editor screen. By doing # /* STEP 7: ELDB TO GLDB EXTRACTION OF DATA FROM TEMPLATES
this you may easily identify your CTL Z120LPSS.CTL

steps. The function will insert a ENV Z120LPSS.ENV

DBA D:\CSLDBS\LPSSELDB.BTE CLDB

oo ; DBA D:\CSLDBS\LPSSGLDB.BTE GLDB
Step identifier (#) in your APP 2120

“STEP nn” comment for each

sequence.
# /* STEP 8: PROXY DAY
ENV PROXYSEQ.ENV
SEA TGE31lE.SEA
HOL TGE31C.HOL
DBA D:\CSLDBS\TSTAXDB.BTE AXDB
DBA D:\CSLDBS\LPSSELDB.BTE ELDB
APP X670

2. Next, specify the name and location of the default Environment files.
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Several programs require special default Environment files. These files are typically protected
from accidental or casual modification, since they are used by multiple programs and are
typically set up according to the policies of your facility (see the Oracle Utilities Load Analysis
Load Data Management User’s Guide for details).

These Environment files are:

FileUsed by procedures...

Validation Environment File (tgd21b.env)D110, X110, X310

Reporter Environment File (tgd41b.env)D110, X110, X210, X220, X310, X410, Y410
Automatic Editor Env File (tgd31b.env)D110, X110, X210

If you include any of the procedures listed above in your sequence, you must specify the
required default Environment files in the Default Environment File Records, using the
following format:

ValidationEnvFile <full-path-and-filename>
ReporterEnvFile <full-path-and-filename>

AutoEditEnvFile <full-path-and-filename>

Examples:
VALIDATIONENVEFILE D:\CSLSTAR\COMMON\DATA\TGD21B.ENV
REPORTERENVFILE D:\CSLSTAR\COMMON\DATA\TGD41B.ENV

AUTOEDITENVFILE D:\CSLSTAR\COMMON\DATA\TGD31B.ENV

The Default Environment File Records must follow the Output Directory (if it is supplied)
and precede the Step Definition Records.

Optional. Specify the COMBINE_INP_REPORTS command to control the behavior of the
input procedure directing it to either combine or separate the individual reports. Valid values
for this command include “YES” (default) and “NO.”

Optional Next, specify parameters for access to interval data stored in Relational tables in the
Oracle Utilities Data Repository.

These parameters ate set with the following keywords:
RDBUSERNAME: User ID used to connect to the Oracle Utilities Data Repository.

RDBPASSWORD: Database password used to connect to the Oracle Utilities Data
Repository.

RDBCONNECTSTRING: The Data Source Name for the Oracle Utilities Data
Repository.

RDBQUALIFIER: Database qualifier used to connect to the Oracle Utilities Data
Repository.
Unless otherwise specified, these values ate used for all programs defined in the sequence file.

These parameters can also be included in Step Definition records if individual programs need
access to different relational data sources.

Optional. Next, specify which language setting the sequencer file will use with LANGUAGE
<language code>. The default value is ENU.

Any <language code> must be configured in the LOCODE.DAT file located in the bins
folder on the server. This file contains keyword - key value pairs. Keywords are the <language
codes> used in the SEQR file LANGUAGE command. Key values are the LCID values of
these keywords found at: http://msdn.microsoft.com/en-us/goglobal/bb895996.aspx
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Note: Each File Command must be
on a separate line within the step
definition.

Note on Required Filename Extensions:

During validation of the SEQ file,
the sequencer program checks to
ensure that filename extensions
conform to Oracle Utilities Load
Analysis standards and
requirements. The required
extensions are in parentheses.
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Examples:

ENU 1033
FRA 1036

For each program in the sequence, create a set of commands that defines the program to be

run, along with its input files and databases.

Each set of commands is called a “Step Definition Record” because it defines one step
(program) in the “job stream.” You must supply the Step Definition Records in the order in
which the programs will process. Do not supply step numbers; the Sequencer adds them

automatically.

The following explains the parts of a Step Definition Record, in the order in which you
should enter them.

a.

To signal the beginning of a Step Definition Record, enter a pound sign (#). Go to the
next line.

Specify the input files for the program in this step using one or more “Input-File
commands.” You can have many Input-File commands in one Step Definition Recotd,
each command specifying one input file. Because there are many types of input files and
ways of obtaining and/or pre-processing them, there are several components that you
can use to build an Input-File Command. Just the first two (keyword and filename) are
required:

<keyword> <filename> <FROMSTEP n> <OPTxSTEP> <RUN pgm> <PARMS parm 1-3>

The first component is a keyword that identifies the type of file to be input to the
program. For this keyword, you must use one of the following (case-insensitive):

CTL (.CTL, .INP, .LSE, .KYS) Input file containing data to be processed (required).
The file referred to in a CTL. Command may be: a Control File, a Load Input
File, or a file that was output from an earlier step, such as a Keylist File.

ENV  (ENV) Environment File.

BNV  (ENV) Base Environment File.

HOL  (HOL) Holiday File.

TOU  (TOU) Time Of Use File.

SEA (SEA) Season File.

USD  (.USD) User-Specified Day File.

KYS (KYS) Input Keys File (Key Generator).
PEA ((PEA) Peak Day File.

GUF  (GUF) Generating Units File (Cost of Service Interface - COSI).
DBL  (.DBL) Record Definition File.

CAF (.CAF) Customer Attribute File.

CYC  (.CYC) Billing Cycle File.

DEM (DEM) Demand File.

CRF (.CRF) COSI Rates File (must be specified in the SEQ File when required by
the program; i.e., there is no default).

CTF (.CTF) COSI Titles File (must be specified in the SEQ File when required by
the program; i.e., there is no default).

RUL  (.RUL) Rules File for X210 (must be specified in order to trigger Auto Editor
commands).
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Note: This parameter, if used, must
directly follow the FROMSTEP
option. If FROMSTEP is not
specified then the OPTxSTEP
must follow the <filename>. This
parameter will be ignored if it is
not placed as previously specified,
or if it is specified for something
other than the CTL and ENV
keywords.

Note about Holiday, TOU, Season, Demand, Billing Cycle, and User-Specified
Day files: Typically, default versions of these files are specified in the CSLSTAR.GLB
Configuration File at system setup. If so, you do not have to specify these files in the Step
Definition Records (if none are specified, the Sequencer will look for the defaults in the
Step Definition Record).

The next item in the Input-File Command is the filename (also required). The filename
identifies the specific file to be input. If you do not provide a full path and filename, one
of the following must be true: a) the file must reside in the directory defined by
SEQINPFILS in the CSLSTAR.GLB, or b) you can use the following parameters in the
Input-File Command to specify that the file comes from an earlier step in the sequence
(see below).

If the input file is to come from an earlier step, use the following parameters:

FROMSTEP n. Optional. This parameter tells the Sequencer to obtain the file defined
by the Keyword from a file produced by Step 7. For example, say you want to use a
Keylist File produced by the second program in the sequence as the Control File for the
third program. In that case, you would include a command in the third Step Definition
Record similar to the following:

CTL TGX31AE.DAT FROMSTEP 2

OPT. Optional. This parameter tells the Sequencer not to check for the existence of the
Input File during the syntax check process. You can use this parameter when the file may
not be present until execution of the Sequencer (for example, when the previous step
copies the file to a specified area).

OPTXSTEP. Optional. If a Control File or Environment File is optional for the program
specified in the step, you can use this parameter to tell the Sequencer whether or not to
run the step if the specified file does not exist at the time of execution. Replace the x
value of the parameter with either RUN or SKIP, as described below.

*  OPTRUNSTEP. This parameter tells the Sequencer to run the step even if the file
specified does not physically exist when this step is executed.

*  OPTSKIPSTEP. This parameter tells the Sequencer to skip the step if the specified
file does not exist at time of step execution. This option will also place the following
message in the SYSPRINT.HTM File in the directory for the step: “This step was
skipped because the OPTSKIPSTEP option was specified”.

If the file identified in the Input-File Command requires pre-processing before it is input
to the step program (such as to update the date value in the Environment File), use the
RUN and PARMS parameters to specify the pre-processing as described below.

*  RUN <pgm>. This parameter tells the Sequencer to pre-process an input file by
executing the program <pgm>. For example, you might want to use the
CSMODENY Program to modify the date parameters in an Environment File
before using that Environment File as input to the program. (See Specifying Dates
in the Sequencer on page 6-10 for a description of two of the programs you can
use to pre-process input files in this way.)

The RUN command can only be used with CTL, ENV and BNV command lines. If
the RUN command is followed by a custom executable, the executable file must
either be located in the BINS folder on the server or you must include a fully
qualified path.

*  PARMS <filename> <SUPPDATE.DAT | FROMSTEPn>. These parameters
tell the program called by RUN what file to pre-process. This file will typically be
either the SUPPDATE.DAT File described in the next section, or a file output by a
previous step. Note: If the RUN keyword is not specified, then PARMS keyword
and any values following it will be ignored. Similarly, if the PARMS keyword is
omitted, any values after the <pgm> value of the RUN keyword will be ignored.

The Program Sequencer 6-7



Establishing Directories for Sequencer-Related Files

Note: When running the Initialize
(Q940, Q941, Q942, Q943) and
the Delete (Q999) Database
programs, the DBA Command
must be specified and must come
after the APP keyword in your
SEQ setup file.
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When using PARMS, the filenames must be fully qualified. The filename must also
be the first parameter listed if there are more than two or more parameters.

For example, the following command would modify the DAT Command in
TGD72B.ENV with the date found in a file that was output by Step 2 — TGX671.DAT.

ENV TGD72B.ENV RUN CSMODENV PARMS TGX671.DAT FROMSTEP 2

C.

Once you have specified all of the necessary Input-File commands for the Step
Definition, specify the database(s) containing the data to be processed in the step and
(depending on the program) the database to write the results to.

Use a Database Command to specify each database involved in the step. The format is:
DBA <full-database-path-and-name> <databasetype>

where:

DBA is the required keyword for the DBA Command.

full-database-path-and-name is the name and location of the database. Note that
spaces cannot be used in the path or filename here.

For example:
DBA D:\CSLDBS\LPSSELDB.BTE CLDB

When accessing tables in the Oracle Utilities Data Repository, specify “RDB/” followed
by the table name.

For example:
DBA RDB/LSCHCLDB CLDB

databasetype is any one of the database types recognized by Oracle Ultilities Load
Analysis, including CLDB (for Edit Database), AXDB (for Auxiliary Database), ELDB
(for Extract Database), GLDB (for Settlement Database), and CLDB2 (for temperature
database), as well as SLDB, RLDB, and ALDB.

For example:
DBA D:\CSLDBS\LPSSELDB.BTE CLDB
When accessing tables in the Oracle Utilities Data Repository

In the Step Definition Record, you must specify the program or procedure to run in the
step. You do that using a Program Command. A Step Definition Record can contain
just one Program Command.

There are two formats for Program commands, depending upon whether the program
or procedure is Oracle Utilities or non-Oracle Utilities (i.e., user-written).

Format for Program Commands (Oracle Utilities Load Analysis)
APP <applid>

Where:

APP is the required keyword for the command.

applid is the ID of the job (see Appendix D: Oracle Utilities Load Analysis
Sequencer Program Input Tables and Keywords or the Oracle Utilities 1.oad Analysis
Quick Reference Guide, for a list of 1Ds).

For example, to specify Direct Input:
APP X110
Using the Repeater with the Sequencer

To run Repeater jobs (see Chapter 7: The Repeater), use the following syntax:



Establishing Directories for Sequencer-Related Files

APP REPEATER <applid>
Where:
APP is the required keyword for the command.

applid is the ID of the job (see Appendix D: Oracle Utilities Load Analysis
Sequencer Program Input Tables and Keywords, or the Oracle Utilities Load Analysis
Quick Reference Guide, for a list of IDs).

Format for Program Commands (other than Oracle Utilities Load Analysis)
PGM <full-pathname> <parameters>

where:

PGM is the required keyword for the command.

full-pathname is the name and location of the executable program.

parameters ate any parameters required by the program. To reference the output
directory (OUTDIR), you can use the “/%JOBDIR%’ variable.

PPM <full-pathname> <parameters>
where:
PPM is the required keyword for the command.

full-pathname is the name and fully qualified location of the parameters file. This value
can also be the name of a parameters file in the SEQINPS folder.

parameters ate any parameters required by the program. To reference the output
directory (OUTDIR), you can use the “/%JOBDIR%’ variable.

Note: The parameters file used by the PPM command will override the parameters in the
PGM command.

Specify a file name for the output file using the OUT1 command. The format for this
command is:

OUT1 <filename>
where:
OUT1 is the keyword for the command

filename is the name of the output file. Note that you cannot specify a path using this
command.

This command controls the name of the output file for the following programs

Program Output File affected

Key Generator Output Keys File

Copy Cuts Keys List file

Prod / Ditect Input Keys List file (TGX112.DAT)
Validation Edit Keys File

Invalid Series Validation — Editor Keys List

Editor Syntax Scan Valid requests (TGX322.DAT)
Billed Energy Analysis Control File (TGY231)
Cust Data Extraction Keys List File (TGY247)
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Program Output File affected
MPU Analysis ICS File (TGY318)
Ratio Analysis ICS File (TGY338)

Domains MPU Analysis  ICS File (TGY358)

Domains Ratio Analysis ~ ICS File (TGY368)

Individual Cust Analysis ~ DLM File (TGY377)

100% Sample Analysis ICS File (TGY388)

Direct Output Extracted Data File

. If desired, you can include a Return Code Command in the Step Definition that specifies
a threshold for aborting the job stream.

The format is:

STP <n>

where:

STP is the required keyword for the command (enter as shown).

n is the maximum allowable return code. If the return code from the program equals or
exceeds n, the job will abort at that step. The default is 99. A list of return codes and
their meanings is provided in the last section of this chapter.

g You have completed your first Step Definition Record. Repeat this process for every
program in the sequence (for a total of up to 99 programs).

You may include comments anywhere in the file, as a helpful reminder to yourself or others
who might use or review your SEQ File. You can even add a comment on the same line as a
command. (See Sample SEQ File on page 6-4.)

Comments are ignored by the programs. A comment must begin with a slash, asterisk, and be
followed by at least one blank space (/* ).

You may have as many comments as you wish.

Save your file. Remember, if submitting the job through the GUI, you must place the file in
the directory that’s identified in the SEQUENCERFILES Keyword in CSLSTAR.GLB, and
the file must have the ‘.seq’ extension.

Specifying Dates in the Sequencer

Many (if not most) of the Oracle Ultilities Load Analysis programs that you’re likely to include in a

sequence require you to specify a date or date range for the data to be processed. For example, the

analysis programs require you to specify the date range of the analysis period; reporting programs

require you to specify the dates to be reported. Depending on the program, these dates are

typically specified in the Date Command in the program’s Environment File. (Or, if you are

submitting the job using the Graphical User Interface, you can specify the dates via the Submit

Panel.) However, if you are designing the program sequence to run automatically in batch mode

on a daily, weekly, or monthly basis, a single static date or date range “hard-coded” in the

Environment File would not be adequate.
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Fortunately, there is a more flexible means of specifying dates. Oracle Corporation has
provided the CSMODENYV utility which is designed specifically for modifying the dates
specified in an Environment File’s DATe and CDA commands just before the program for
the step is run. You can use the Input-File Command’s Run parameter (described on page 6-
7) to specify that that this utility “pre-processes” an Environment File before it is input to the
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CSMODENV

SUPPDATE.DAT

program for the step. The date applied by these utilities to the Environment File can come
from one of several sources:

*  An output file from a previous step

*  An external file called SUPPDATE.DAT (SUPPDATE.DAT is a simple text file containing
two dates). The SUPPDATE file, if used, must be specified after "RUN CSMODENV"

CSMODENYV changes the DAT Command in an Environment File to the date(s) stored in a file
that you specify with the Input-File Command’s PARMS parameter. The file containing the dates
can be output from a previous step; alternatively, you can use the SUPPDATE.DAT File.

Example:
ENV TGD72B.ENV RUN CSMODENV PARMS TGX671.DAT FROMSTEP 2

The above example modifies the DAT Command in TGD72B.ENV with the date found in a file
output by Step 2 — TGX671.DAT. If the Sequencer cannot find the file, it issues a return code
9400 + 7 (where # is the step number).

SUPPDATE.DAT is a simple text file containing just a start-date and a stop-date — both in the
mm/dd/yy format. For example:

01/01/99 01/31/99

The purpose of SUPPDATE.DAT is to provide a consistent place where CSMODENYV can find
the dates to be applied. To change the dates in the file, you can either update them manually using
Notepad or another editor, or your System Administrator may set up a routine to update the file
automatically. For example, your facility might create a routine that modifies the dates to match
the date on the system clock. In either case, SUPPDATE.DAT must reside in the SEQINPFILS
directory.

A Note about the date files:

A date file is a simple text file that contains just a start-date and a stop-date. Both dates must be in
the mm/dd/yy format. For example:

01/01/99 01/31/99
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Running the Sequencer via Windows Schedule Service

Once you have created the SEQ and input files as described on the previous pages, you can use
the AT Command included in the Windows Schedule Service to run the sequence in batch mode.
You could schedule it to run once at a future date and time, or repeatedly every time a particular
day of the week or date of the month occurs.

Note: Oracle Utilities Load Analysis does not provide security when submitting and/or running a
sequence in batch mode. Security and access rights when submitting and/or running a sequence in
batch mode is handled by restricting access to the application server through Windows security.

Setting Up the AT Command Batch File

Tip: You can use Notepad,
WordPad, or any other ASCII text
editor to create this batch file. A
sample file SETUPSEQ.BAT) can
be found in your SEQFILES
directory.

In order to use the AT Command to run a job stream, you must create a batch file containing the
following commands:

C:
CD C:\CSLSTAR\BINS
CSLSSERVER SEQUENCER %1

Modzfy the first line to point to the drive that contains your BINS directory. Modify the second line to point to your
BINS directory. Leave the last line as-is. The first two commands change the current directory to the
directory specified (this should be your BINS directory where all of the Oracle Utilities Load
Analysis programs and executables reside). The last command triggers the Sequencer Program
using the SEQ File you will specify with the AT Command (explained below).

You must store this batch file on the Server machine.

Using the AT Command to Schedule a Program Sequence

Note: The Windows Schedule
Service must be running to use the
AT Command. See your Windows
manual for instructions.

At a DOS prompt, type the following command to schedule the job:

AT <time> <batchfile> <SEQ-file> <“>errorfile”>
where:

AT is the required keyword for the command.

time specifies the time the job is to run; expressed in hours:minutes. 00:00 represents midnight;
23:59 is the last minute of the day.

You can add ecither of the following switches to the time parameter to further specify when
the job is to be executed:

/next:date(s) specifies that the job is to be run once at the indicated time on the next
occurrence of each day you provide in a comma-separated list. You can specify days of the
week and/or dates of the month. For example,

12:00 /next:1,15,Friday

means run the job at noon on the next 1st and 15th day of the month (could be this month or
next), as well as the next Friday.

/every:date(s) specifies that the job is to be run each time the specified days of the week
and/or dates in the month occur. For example,

12:00 /every:1,15,Friday

means run the job at noon on the 1st and 15th day of every month, as well as every Friday.
batchfile is the AT Command batch file described in the section above. Must be fully qualified.
SEQ-file is the name of the Sequence Setup (SEQ) file you wish to run.
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“errorfile” is the user-specified destination (full path and filename) for program and error
messages produced by the job. Must have double-quote marks surrounding it, and begin with the
pointed bracket >, as shown below.

Example:

AT 14:00 c:\batchfiles\segsetup seqfile “>c:\cslstar\sqgncr\error.log”

The example command above schedules SEQSETUP from the batchfiles directory to run at 2:00
pm using SEQFILE.SEQ. In this example, the Sequencer will write any errors or messages
encountered in the run to:

c:\cslstar\sgncr\error.log

The job will run in background mode without additional user intervention, as long as the
Windows Schedule Service is properly set up and running. (See your Windows documentation for
details.)
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Sequencer Output

The output is placed in the directory that you specified using the Base Output Directory record.
Alternatively, if you submitted the job via the GUI and did not provide a Base Output Directory
record in the SEQ File, the output is in the job directory that you named using the Job
Parameters dialog box.

In addition, the program will create a SETUP.REP File in the root job directory, which contains a
report of the compilation of the setup file.

Return Codes from Sequencer

0
929
101
110
115

120

130
990

999
1000 + n

2000 + n

3000 + n

4000 + n

5000 + n

5500 + n

5600 + n

6000 + n

6100 + n

6200 + n

6300 + n

6-14 Load Analysis User’s Guide

Successful for all runs.

Program terminated abnormally.

The setup file for (.SEQ) not present in Sequencer Area.
CSLSTAR.GLB File not present in cuttent directory.

The Specified Output directory already exists, does not exist, or cannot be
reached. Specify a different ditectory or delete the existing directory.

Required OUTDIR specification not found or was incorrectly placed in
setup (SEQ) file.

Required default files not found in setup (SEQ) file.

Steps in SEQ File exceeds the maximum allowable number of steps, which
is 99.

Unrecognized keyword in setup file.

A control file was missing, incorrectly placed in the setup file for iteration
#, or has an improper filename extension.

An environment file was missing, incorrectly placed in the setup file for
Step #, or has an improper filename extension.

The Holiday File specified in the setup file for Step # does not exist, or has
an improper filename extension.

The Time-Of-Use File specified in the setup file for Step # does not exist,
or has an improper filename extension.

The Season File specified in the setup file for Step 7 does not exist, or has
an improper filename extension.

The file specified with FROMSTEP option does not exist for execution in
Step 7.

The DBA keyword is required when running the delete database program
(Q999) and was not specified in Step #, or the file has an improper
filename extension.

The User-Specified Day File specified in the setup file for Step 7 does not
exist, or has an improper filename extension.

The Record Definition File was missing in the setup file for Step #, or has
an improper filename extension.

The Generation Units File was missing in the setup file for Step 7, or has
an improper filename extension.

The Customer Attribute File was missing in the setup file for Step #, or has
an improper filename extension.
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Reminder: Database paths cannot
contain spaces.

6400 + n

6500 + n

7000 + n

7100 + n

7200 + n

7300 + n

7400 + n

7500 + n

7600 + n

7700 + n

8000 + n

8100 + n

8200 + n

8300 + n

8400 + n

8500 + n
8600 + n

9000 + n

9100 + n

9200 + n

9400 + n
9600 + n

9700 + n

9800 + n

+ -rc

The Peak Day File was missing in the setup file for Step #, or has an
improper filename extension.

The Input Keys File was missing in the setup file for Step 7, or has an
improper filename extension.

A Database File was missing, incorrectly placed in the setup file for step 7,
or has an improper filename extension.

Invalid Database Type was specified in the setup file for Step 7, or has an
improper filename extension.

A Rates File was missing or incorrectly placed in the setup file for Step 7,
or has an improper filename extension.

A Titles File was missing, incorrectly placed in the setup file for Step #, or
has an improper filename extension.

A Billing Cycle File was missing, incorrectly placed in the setup file for
Step 7, or has an improper filename extension.

A Demand File was missing, incorrectly placed in the setup file for Step #,
or has an improper filename extension.

An autoeditor RULes File was missing or incorrectly placed in the setup
file for Step 7.

The Supplied Date File was missing, incorrectly placed in the setup file for
Step #, or has an improper filename extension.

The APPlication File was missing or incorrectly placed in the setup file for
Step #.

The program file was missing or incorrectly placed in the setup file for
Step #.

The Program Parameters File was missing or incorrectly placed in the
setup file for Step 7.

The Program Parameters File is required for this step but no PPM value
was found in the setup file for Step 7.

The specified DBPARMS.INF File was missing or incorrectly placed in the
setup file for Step 7.

The required datefile SUPPDATE.DAT) was not found for Step 7.

The required Rate Schedule parameter was missing or incorrectly placed
for RUNRS execution in Step 7.

Execution of Oracle Utilities Load Analysis program failed or exceeded
specified stop code in Step 7 The “- rc” following this return code is the
actual return code from the program executed in Step 7.

No program to run was specified in the setup file for Step 7.
The stop value in the setup file for Step # was not numeric.
The file specified in the PARMS parameter of Step # was not found.

The file specified in the PARMS parameter of Step # was not found and is
required to run CSMODENV.

Required parameter for CSMODENY was not specified in the setup file
for Step 7.

Sequencer was unable to create a required file for Step #. Please contact the
Oracle Utilities Helpline.
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Chapter Seven

The Repeater

The Repeater makes it possible to run the Standard Load Analysis, Ratio Analysis, Domains, or
100% Sample Analysis program multiple times — but you only have to submit the job once. For
each pass of the program, you can vary the analysis parameters, the set of cuts to be analyzed, or
both.

Using the Repeater to Run Program Multiple Times

The Repeater is a convenient feature that enables you to apply the Standard Load Analysis (Y310),
Ratio Analysis (Y330), Domains Analysis Programs (Y350/Y360), or 100% Sample Analysis
(Y380) program multiple times in one job submission. This means that you can apply an analysis
program a number of times with different parameters and/or a different sets of cuts—without
having to re-submit the job for each variation.

Control and Environment Files

You specify each set of cuts to be analyzed in a Control File, and you specify the analysis
parameters to be applied to it in a matching Environment File. (The specifications for the contents
of these files are the same as the process you are running, such as Y310, regardless of whether or
not you are using the Repeater; see the Oracle Utilities 1.oad Analysis Load Data Analysis User’s Guide
for details.)

Control files must be identified with the “.CTL” extension. For each Control File, you must supply
a matching Environment File that contains the analysis parameters to be applied to the data in the
corresponding Control File. The Environment File must have the same name as its corresponding
Control File, with an “e” appended to the filename. The Environment File must be identified with
the “.ENV” extension. So, if a Control File was named MYCUTS.CTL, the Environment File
associated with it must be named MYCUTSE.ENV.

You must put all of the Control and Environment files for the Repeater run in one folder located
on the server. When you submit the job, the Repeater antomatically runs the analysis program as many times as
there are Control File/ Environment File pairs in the folder. This folder must be located on the setver in
the COMMON\REPEATERN\ <application-id> foldet. For example, if you intend to run multiple
analysis for all rate classes for Ratio Analysis (Y330), you must place all control/environment file
pairs that you have created in the folder:

<your server install folder>\COMMON\REPEATER\Y330
All users should have access to this folder.

The application identifier of the analysis program (Y310, Y330, Y350, Y360, or Y380) must be
used as the name of the folder containing the file pairs.

Note: Add the Server setting “RPTR_RENAME_ICS” setting with a value of “CTL” to the
Server configuration run-time file (CSLSTAR.GLB) to cause the Repeater rename the ICS file in

The Repeater 7-1



Note: To see the job directories,
double-click on the job name for
that Repeater run.

7-2 Load Analysis User’s Guide

the output folders to conform to the associated control file for that iteration. This helps avoid
having all the ICS files named the same.

The Repeater also accepts an unmatched environment file, one for each Analysis program and
located in the same folder as the Control and Environment files for each application ID that is
used to contain common environment file commands used for all runs. This is called a repeater
Base Environment file (BNV). This file may contain common commands, such as PEAk or
DATe, used for each iteration. When using a base environment file, you would remove the
command contained in the file from the Matched Environment files. When the repeater runs, it
will append to all environment files prior to program execution the contents of the Base
Environment file. It will NOT check to see if there are already the same commands in the file it is
modifying. The Oracle Utilities L.oad Analysis Graphical User Interface will show all unmatched
.ENV files in the appropriate repeater folder in the “Base Environment File” selection list.
Selecting “None” will run the repeater using solely the content of each matched environment file.

How to Run the Repeater:

1. From the Oracle Utilities Load Analysis desktop, go to the Submit Panel for the analysis
program that you want to run in the Repeater mode.

The following programs can be used in this mode:

Standard Load Analysis (Y310), Ratio Analysis (Y330), Domains Analysis Programs (Y350/
Y360), and 100% Sample Analysis (Y380).

2. Click the Repeater Disabled button. It will display Repeater Enabled to show that the
Repeater is on.

3. Select the databases that you want to apply the job to.
4. Select a Control File. (This is not required to successfully submit a job.)

If the control file is associated with an environment file, that file will appear in the
Environment File field. If it does not have an associated environment file the field will display
“none.” This is an indication that you do not have a matching environment file for that
control file. You may choose to edit any of these files.

5. This step is optional. Select a Base Environment (BNV) File.

The Base Environment File drop-down list appeats when the repeater is enabled. The list
displays all environment files in the repeater folder that are not matched to a control file. The
contents of the BNV file will be appended to the environment files for each step. You may
choose to edit this file.

6. Click File Preview if you want to preview the selected environment, control, and base
environment files.

7.  Click the Submit button.
The Job Parameters panel appears.

8. Review the results (if you need additional information about using the Oracle Utilities Load
Analysis Graphical User Interface to examine the output, see Chapter Three: Working with
Jobs in this guide).

If an error occurs in one of the analysis passes, Oracle Utilities Load Analysis creates a log file
(REPTRERR.LOG) and places it in the root job directory. Even if it encounters errors, the
job continues to run to the end.

The Repeater groups the output of each program run in subfolders under the job folder (the
name of the job folder was specified in the Job Name field in the Job Parameters dialog box
illustrated above). You may need to click the Refresh Results button on the toolbar to see
these folders. Each subfolder is named according to the Control File used in the run. For
example, if the Control File was TGY31aa.ctl and the Job Name was Y3302041, the output
for the run would be found in <job drive>\Y3302041\TGY31AA.



Return Codes

The following return codes signal an error. These codes can appear in the Queue window or the
output reports.

99 The Analysis program failed for one or more Control files
100099 Could not open Control File
100100 Syntax error
100101 Error condition
100102 Halt condition (ctl-c)
200000+ Maximum return code from Oracle Ultilities L.oad Analysis program indicates

that there were either Control or Environment files that could not be found.
Check the REPTRERR.LOG in the root job directory for details.

The Repeater 7-3



7-4 Load Analysis User's Guide



Appendix A

Programs Available via Oracle Utilities Load
Analysis

This appendix lists each of the Oracle Utilities .oad Analysis programs that you can use via the
Oracle Utilities Load Analysis graphical user interface, including a brief description of each
program’s application and where you can go to find detailed operating instructions for it.
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Category Program

Application

Reference

Input AXDB Update Specify automatic modifications to incoming Oracle Utilities Load Analysis Load Data Management
(X180) customer interval data; used in conjunction with User’s Guide, Chapter 7
Direct input and Production Input programs.
Direct Input (D110) Input INP format interval data from a local drive Oracle Utilities Load Analysis Load Data Management
to a Oracle Utilities Load Analysis database User’s Guide, Chapter 5
Direct Input Input .LSE format interval data from a local dtive Oracle Utilities Load Analysis Load Data Management
(X110, Y130) to a Oracle Utilities Load Analysis database User’s Guide, Chapter 5
Manual Entry Input manually-created data files into a Oracle Oracle Utilities Load Analysis Load Data Management
(X120, Y220) Utilities Load Analysis database User’s Guide, Chapter 5
Production Input (D111) Input .INP format interval data from a network file Oracle Utilities Load Analysis User’s Guide, Chapter
server to a Oracle Utilities Load Analysis database Five
Production Input Input .LSE format interval data from a network file Oracle Utilities Load Analysis User’s Guide, Chapter
(X111, Y131) server to a Oracle Utilities Load Analysis database Five
Validation Cut Series Validation Check newly-entered, newly-edited, or user- Oracle Utilities Load Analysis Load Data Management

(X210)

specified cuts in the CLDB to ensure that the data
is accurate and error-free

User’s Guide, Chapter 11

Invalid Series Validation

(X220)

Generate a key list of invalid cuts

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 14
(see X810)

Delete Cuts

Editing Do

Delete a cut and all its associated records from a
Oracle Utilities Load Analysis database

Oracle Utilities Load Analysis User’s Guide, Chapter
Five

Load Data Editor
(X310, Y630)

Modify cuts stored in either the CLDB or the
ELDB

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 9

Load Data Editor Syntax Scan

(X320)

Check edit commands prior to editing the cuts.

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 9

AXDB Summary

Reporting N0

Report contents of the AXDB

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 7

Cut Series Gap Reporter
(X490, X491, Y490, Y491)

Identify gaps in interval data

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 16 (see X490)

Cut Series Overlap Reporter (X530,
Y530, X531, Y531)

Identify overlaps in interval data

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 16 (see X530)

Late Cut Reporter

(X470)

Identifies missing data by compating cut stop-dates
to a specified point in time

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide (Optional Extension)

Load Data Reporter
(X410, X420, Y420, Y430)

Report contents of selected customer load data
records or computed statistics

(X410 for CLDB, X420 for ALDB, Y420 for
ELDB, Y430 for SLDB)

Oracle Utilities Load Analysis Load Data Management
Uset’s Guide, Chapter 12

Summary Reporter
(X440, X460, Y440, Y460)

Report summary information about records in the
database

(X440 for CLDB, X460 for ALDB, Y440 for
ELDB, Y460 for SLDB)

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 12

Time Series Reporter
(X400, Y410)

Report selected cuts or statistics in tabular format
(columns and rows)

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 12

Totalizing Reporter
(X430, Y450)

Report load profile data and summary statistics for
multiple channels of data

Oracle Utilities Load Analysis Load Data Management
User’s Guide (Optional Extension)

Validation Statistics Reporter

(X480)
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and reports summary statistics on failing cuts
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Category Program Application Reference
Retrieval Copy Cuts Copy data from one Oracle Utilities Load Analysis Oracle Utilities Load Analysis User’s Guide, Chapter
(Q91C) database to another Five
Load Data Rettieval Copy cuts from the ALDB back to the CLDB, Oracle Utilities Load Analysis Load Data Management
(X660) allowing you to re-examine and revise them as User’s Guide, Chapter 15
needed
Data Retrieval Copy cuts from the SLDB back to the ELDB, Oracle Utilities Load Analysis Load Data Analysis
(Y960) allowing you to re-examine and revise them as User’s Guide, Chapter 17
needed
Data Billed Energy Compute energy use from demand; create control Oracle Utilities Load Analysis Load Data Analysis
. (Y230) files for Analysis programs User’s Guide, Chapter 13
Extraction
Direct Output Output Oracle Utilities Load Analysis data for use Oracle Utilities Load Analysis Load Data Analysis

(X720, X740, Y720, Y740)

with Interval Data Manager and non-Oracle
Utilities programs

User’s Guide, Chapter 16

Load Data Extraction

(Y240)

Copy load data from the ALDB and/or CLDB into
the ELDB to be used with the Oracle Utilities Load
Analysis Analysis programs

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 5

Statistical Package
(X710, Y710)

Output load data in file formats compatible with
third-party software file formats

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 16

Analysis

100% Sample Analysis
(Y380)

Compute load statistics for 100% sampled
populations, such as large industrials

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 8

Aggregate Load Analysis
(Y320)

Combine individual rate class statistics into
estimates for major customer classes and total
system load

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 9

Coincident Peak Analysis

(Y340)

Estimate the mean and corresponding sampling
error for up to 12 periods of coincident peak
demand for a customer class.

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 10

Day Type Analysis
(X760, X770, Y760, Y770)

Produce 24-hour average hourly load profiles for
up to 48 daytypes in a year.

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 18

Domains Analysis MPU
(Y350)

Compute statistics for one or more subpopulations
in an existing sample, using mean per unit
expansion

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter Two

Domains Analysis Ratio

(Y360)

Compute statistics for one or more subpopulations
in an existing sample, using the “combined
estimate” technique

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter Two

Individual Customer Analysis

(X370, Y370)

Compute time-of-use, entire period, and average
day statistics and reports

Oracle Utilities Load Analysis Load Data Analysis User’s
Guide

Ratio Analysis

(Y330)

Compute class- and strata- level statistics for
sample customer data using ratio expansion

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 7

Standard Load Analysis

(Y310)

Compute class- and strata- level statistics for
sample customer data using mean per unit
expansion

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide, Chapter 7

Query

Customer Data Extraction

(Y110)

Identify customers that match a set of user-defined
critetia (according to data in the Customer
Attribute File)

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 14

Key Generator
(X810, X820, Y810, Y820)

Create lists of cut keys or edit blocks that match a
set of user-defined criteria

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 13
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Category

Program

Application

Reference

Administrator Customer Record Definition Create a file that contains a table describing the Oracle Utilities Load Analysis Load Data Analysis
(Y120) format of the Customer Attribute File. User’s Guide, Chapter 14
Initialize AXDB Initialize AXDB Oracle Utilities Load Analysis Configuration Guide
(Q941)
Initialize CLDB/ALDB Initialize a new CLDB or ALDB Oracle Utilities Load Analysis Configuration Guide
(Q942)
Initialize ELDB, SLDB Initialize a new ELDB or SLDB Oracle Utilities Load Analysis Configuration Guide
(Q940)
Move Cuts Move a cut and all associated records from one Oracle Utilities Load Analysis User’s Guide, Chapter
(QI1M) database to another. Five
Scan Archive/Delete Move cuts from the CLDB to the ALDB, making Oracle Utilities Load Analysis Load Data Management
(X910) cuts available for analysis User’s Guide, Chapter 15
Archive/Delete Move cut statistics from the ELDB to the SLDB, Oracle Utilities Load Analysis Load Data Analysis
(Y910) making cuts available for analysis User’s Guide, Chapter 17

Transformati Load Data Transformation Calculate new data from existing data (e.g. apply Oracle Utilities Load Analysis Load Data Analysis
(X620, Y620) loss factors, compute KVA, or combine multiple User’s Guide, Chapter 15

on

channels of data) in CLDB and ELDB

GLDB/
RLDB

Initialize GLDB/RLDB
(Q943)

Initializes a new GLDB or RLDB

Oracle Utilities Load Analysis Configuration Guide

Other (COSI)

Allocate Sampling Error

Allocates unexplained sampling error among rate

Oracle Utilities Load Analysis Cost of Service Interface

(G210) classes User’s Guide, Chapter Eleven
Allocate T&D Losses Allocate transmission and distribution losses and Oracle Utilities Load Analysis Cost of Service Interface
(G250) unbillable loads to rate classes User’s Guide, Chapter Twelve

Cost Allocators
(G610)

Develop cost allocation factors

Oracle Utilities Load Analysis Cost of Service Interface
User’s Guide, Chapter Thirteen

Direct Input

Input interval data into GLDB

Oracle Utilities Load Analysis Cost of Service Interface

(G110) User’s Guide, Chapter Six

Direct Output Output data from GLDB in Oracle Utilities or EET Cost of Service Interface User’s Guide,

(G720) format Chapter Fifteen

Editor Modify cut keys and cut data in the GLDB Oracle Utilities Load Analysis Cost of Service Interface
(G310) Uset’s Guide, Chapter Ten

Energy Allocators
(G130)

Develop interval data from total energy values and
input to GLDB

Oracle Utilities Load Analysis Cost of Service Interface
User’s Guide, Chapter Nine

Probability of Dispatch
(G630)

Compute time differentiated cost allocators

Oracle Utilities Load Analysis Load Data Analysis
User’s Guide

Rates Reporter
(G410)

Report load data and statistics at each level of data
development in COSI

Oracle Utilities Load Analysis Cost of Service Interface
User’s Guide, Chapter Fourteen

ELDB/SLDB Extraction
(2120)

Extract data from ELDB or SLDB and inputs into
GLDB

Oracle Utilities L.oad Analysis Cost of Service Interface
User’s Guide, Chapter Seven

Statistics Output
(G710)

Output statistics from GLDB for use in other
programs, such as spreadsheets

Oracle Utilities L.oad Analysis Cost of Service Interface
User’s Guide, Chapter Sixteen

Summary Reporter

(G440)

List contents of the GLDB or RLDB and database
statistics

Oracle Utilities Load Analysis Cost of Service Interface
Uset’s Guide, Chapter Fourteen

Time Series Reporter
(G430)

Report user-selected statistics or cuts in tabular
format

Oracle Utilities Load Analysis Cost of Service Interface
Uset’s Guide, Chapter Fourteen

Key Generator

(G810)

Create lists of cut keys or edit blocks that match a
set of user-defined criteria

Oracle Utilities Load Analysis Load Data Management
User’s Guide, Chapter 18

Other
(Sampling)

Multidimensional Population Analysis

(B220)

Create sample cells and assign customers to them

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Six
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Category

Program

Application

Reference

Multidimensional Sample Design

(B320)

Determine sample size for a multidimensional
sample design

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Fight

Multidimensional Sample Selection
(B420)

Draw a list of customers for participation in a
multidimensional sample design

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Ten

Population Data File Conversion

(B960)

Convert a population data file

Oracle Utilities Load Analysis Sampling User’s Guide

Record Definition

(B110)

Define the record format of the Population Data
File so other Sampling programs can read it

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Three

Sample Validation

(B520)

Validate the sample selection for a
multidimensional design

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Eleven

Single Dimensional Population
Analysis

(B210)

Analyze population frequency distribution

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Four

Single Dimensional Sample Design

B310)

Define state boundaries and determine the sample
size of a single dimensional sample design

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Five

Single Dimensional Sample Selection

(B410)

Draw a list of customers for participation in a single
dimensional sample design

Oracle Utilities Load Analysis Sampling User’s Guide,
Chapter Nine

Other

Proxy Day Selection

Finds a past day that most closely matches a target

Oracle Utilities Load Analysis Load Data Analysis

(X670) date in terms of user-specified criteria User’s Guide
Sequencer Runs a user-specified sequence of programs Oracle Utilities Load Analysis User’s Guide, Chapter
(SEQR) Seven
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Appendix B

Oracle Utilities Load Analysis Naming
Conventions

This appendix lists each of the conventions used to identify programs and files in Oracle Utilities
Load Analysis.

Input and Output Files

The following three-letter file name extensions are used in Oracle Utilities Load Analysis to
identify input and output files:

File Type Extension Must use?
Inputs

Environment .env Yes
Control .ctl Yes

Common (user-editable)

Holiday .hol Yes
Time-of-Use .tou Yes
Season .sea Yes
Demand Period .dem Yes
User-Specified Days .usd Yes
Billing Cycle .cyc Yes
Peak Days .pea Yes
Common (read-only) inf Yes
Direct Input np Yes
Direct Input Ise Yes
Local Input Anp Yes
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Production Input Anp Yes
Production Input Ise Yes
Sequencer Setup File .seq Yes
Outputs
Reports .rep No. System Administrator can assign a
different name in the CSLSTAR.GLB
configuration file.
Data .dat No
kys No
srt No
Run Logs log No. System Administrator can assign a

different name in the CSLSTAR.GLB
configuration file.
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Programs

Programs

In Oracle Utilities Load Analysis, the following conventions are used to identify programs:

Program for...

Convention

Data Management
Subsystem

Do or Xoexx
where xxx is the program number*.
For example, D110 identifies the Direct Input
Program for .INP files, and X410 identifies the
Load Data Reporter for the CLDB.

Load Analysis
Subsystem

Eoaeoxaox or Yooax
where xxx is the program number*.
For example, E130 identifies the Direct Input
Program for .INP files, and Y330 identifies the
Ratio Analysis Program.

Oracle Utilities LLoad
Analysis
Administration

Quexex: where xxx is the program number*.
For example, Q91D identifies the
Delete Cuts Program.

Cost of Service
Interface Subsystem

Goaxx ot Zxxex:
where xxx is the program number*.
For example, G210 identifies the
Allocate Sampling Error Program, and Z120
identifies the ELDB/SLDB Extraction
Program.

Sampling Subsystem

Bowex where xxx is the program number*.
For example, B520 identifies the
Sample Validation Program.

* The Quick Reference Guide offers a comprehensive list of all program names and numbers.
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Templates

Templates

Oracle Utilities Load Analysis recognizes Environment File and Control File templates by the

following file names:

Template Convention

For Control Files TGxnnA.tem

where x is the Oracle Utilities Load
Analysis subsystem (D or X for Load
Data Management and E or Y for Load
Analysis) and 7z is the first two digits of
the program number*. For example,
TGY33A.tem is the template for Ratio
Analysis Control files in the Load
Analysis Subsystem.

For Environment Files TGxnnB.tem

where x is the Oracle Utilities Load
Analysis subsystem (D or X for Load
Data Management and E or Y for Load
Analysis) and 7 is the first two digits of
the program number*. For example,
TGY33B.tem is the template for Ratio
Analysis Environment files.

* The Quick Reference Guide offers a comprehensive list of all program names and numbers.

Template files are located in the Common\Data folder on the server machine.
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Appendix C

Oracle Utilities-Supplied Input Files

This appendix lists each of the test input files that Oracle Corporation supplies with Oracle
Utilities Load Analysis. You can use these files as a starting point for your own work.

When delivered by Oracle Utilities, they are named according to the conventions used to identify
templates (T'GxnnA.tem and TGxzuB.tem). That means they will appear when you click the
Template button in the File Composer window. (See Templates on page B-4 for an explanation
of the naming conventions for templates.)
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Category Program Name Control File Environment File Other Input
Input AXDB Update TGX18A TGX18B
(X180)
Direct Input for .INP NA TGY13B
format
(D110, E130)
Direct Input for .LSE NA TGY13B, TGX41C TGX11E (load data)
format TGY13E
(X110, Y130)
Manual Entry TGY22A NA
(X120, Y220)
Production Input for NA TGD11B, TGE13B TGD11E (load data)
INP format (D111, TGEI13E (load data)
E131)
Production Input for NA TGY13B TGX11E (load data)
.LSE format (X111, TGY13E (load data)
Y131)
Validation Cut Series Validation TGX21A TGX21B
(X210)
Invalid Series Validation =~ TGX22A
(X220)
Editing Delete Cuts TGQI1DA TGQ91DB
(QI1D)
Load Data Editor TGX31A TGX31B
(X310, Y630)
Load Data Editor TGX32A TGX32B
Syntax Scan
(X320)
Reporting AXDB Summary NA TGX17B
(X170)
Late Cut Reporter TGX47A TGX47B

(X470)

Load Data Reporter
(X410, X420, Y420,
Y430)

TGX41A, TGX42A,
TGY42A, TGY43A

TGX41B, TGY42B,
TGX42B, TGY43B

TGY31C, TGY31D,
TGY31E

Summary Reporter TGX44A TGX44B
(X440, X460, Y440,

Y460)

Time Seties Reporter TGY41A TGY41B
(X400, Y410)

Totalizing Reporter TGX43A TGX43B

(X430, Y450)
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Validation Statistics
Reporter

(X480)

TGX48A

Cut Series Gap Reporter
(X490, X491, Y490,
Y491)

TGX49B

Cut Series Overlap
Reporter

(X530, X531, Y530,
Y531)

TGX53A

TGX53B

Retrieval

Copy Cuts
(Q910)

TGQI1CA

TGQI1CB

Data Retrieval

(Y960)

TGY96A

TGY96B

TLoad Data Retrieval

(X660)

TGX66A

TGX66B

Data Extraction

Category

Billed Energy
(Y230)

TGY23A

TGY23B

Direct Output for .INP
format
(D720, D740, E740)

TGY72A

TGY72B

Direct Output for .LSE
format

(X720, X740, Y720,
Y740)

TGY72A

TGY72B

Program Name

Control File

Environment File

Other Input

Analysis

Statistical Package

(X710, Y710)

TGXT71A, TGY71A

TGX71B, TGY71B

Load Data Extraction

(Y240)

TGY24A

TGY24B

Aggregate Load
Analysis
(Y320)

TGY32A

TGY32B

TGY31C, TGY31D,
TGY31E

Coincident Peak
Analysis

(Y340)

TGY34A

TGY34B

Day Type Analysis
(X760, X770, Y760,
Y770)

TGXT6A, TGXTTA,
TGY76A, TGYTTA

TGX76B, TGY76B,
TGX77B, TGY77B

TGY31C, TGY31D

Domains Analysis MPU
(Y350)

TGY35A

TGY35B

TGY31C, TGY31D,
TGY31E, TGY31F

Domains Analysis Ratio

(Y360)

TGY30A

TGY36B

TGY31C, TGY31D,
TGY31D, TGY31F
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Individual Customer
Analysis (X370, Y370)

TGX37A, TGY37A

TGY37B, TGY37B

TGY31C, TGY31D,
TGY31E, TGY23E,
TGY37E

Ratio Analysis TGY33A TGY33B TGY31C, TGY31D,
(Y330) TGY31E, TGY31F
Standard Load Analysis TGY31A TGY31B TGY31C, TGY31D,
(Y310) TGY31E, TGY31F
100% Sample Analysis TGY38A TGY38B TGY31C, TGY31D,
(Y380) TGY31E
Query Customer Data TGY11A NA
Extraction
(Y110)
Key Generator TGXS81A NA
(X810, X820, Y810,
Y820)
Administrator Delete Database NA NA
(Q999)
Initialize AXDB NA NA
(Q941)
Initialize ELDB/SLDB NA NA
(Q940)
Move Cuts TGQI1IMA TGQ91MB
QM)
Archive/Delete TGY91A NA
(Y910)
Customer Record TGY12A NA
Definition
(Y120)
Initialize CLDB/ALDB  NA TGQ942B
(Q942)
Scan Archive/Delete TGX91A TGX91B
(X910)
Transformation Load Data TGX62A, TGY62A TGX62B, TGY62B TGY31C, TGY31D
Transformation
(X620, Y620)
Other (COSI) Allocate Sampling Error ~ NA TGG21B TGG21C
(G210)
Allocate T&D Losses TGG25B TGG21C, TGE31D,
(G250) TGE31C
Cost Allocators TGG61B TGG61C, TGG21C,
(G610) TGE31D, TGE31C,
TGG61D
Direct Input TGG11B

(G110)
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Initialize GLDB/RLDB ~ NA
(Q943)

Category Program Name Control File Environment File Other Input

Direct Output TGGT2A TGG72B
(G720)

Editor TGG31A
(G310)

ELDB/SLDB TGZ12A TGZ12B
Extraction

(2120)

Energy Allocators TGG13A TGG13B
(G130)

GLDB Key Generator TGGS81A
(G810)

Probability of Dispatch TGGO63B TGG21C, TGG63D,
(G630) TGE31D, TGE31C,
TGGO63E

Rates Reporter TGG41B TGG41C, TGG21C,
(G410) TGE31D, TGE31C

Statistics Output TGG71B TGG21C, TGE31D
(G710)

Summary Reporter- TGG44A TGG44B
GLDB
(G440)

Summary Reporter- TGG45B
RLDB
(G450)

Time Series Reporter TGG43A TGGA43B
(G430)

Other (Sampling)  Multidimensional TGB22A SCDB, TGB22C
Population Analysis

(B220)

Multidimensional TGB32B TGB32A
Sample Design

(B320)

Multidimensional TGB42A SCDB, TGB22C,
Sample Selection (B420) TGB22A

Record Definition TGB12A SCDB
(B110)

Sample Validation TGB52A, TGB52B,
(B520) TGB52C

Single Dimensional TGB21A SCDB, TGB22C
Population Analysis

(B210)
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Single Dimensional TGB31B TGB31A
Sample Design

(B310)

Single Dimensional TGB41A SCDB, TGB22C,
Sample Selection TGB22A

(B410)

Proxy Proxy Day Selection TGXG67B
(X670)
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Appendix D

Oracle Utilities Load Analysis Sequencer
Program Input Tables and Keywords

Base Keywords

This appendix lists the basic components of Step Definition Records for each
Oracle Utilities Load Analysis program that you can include in a SEQ File. (See
Chapter Six: The Program Sequencer for detailed information about SEQs.)

Keywords ate case-insensitive.

CTL

ENV
BNV
HOL
TOU
SEA
USD
KYS
PEA
GUF
DBL
CAF
CYC
DEM
DBA

CRF
CTF

ConTroL filename (required) / INPut (INP) filenames will be accepted hete as
well as files ending with the extension set by the ANALMASK Command in
CSLSTAR.GLB.

ENVironment filename (required)
Base eNVironment filename
HOLiday filename (optional)
Time Of Use filename (optional)
SEAson filename (optional)
User Specified Day filename
Input Keys File (Key Generator)
PEAk Day File

Generating Units File (COSI)
Record Definition File
Customer Attribute File

billing CYCle filename
DEMand filename

DataBAse to use (Fully Qualified) - can have several DBA entries within one
block, parameter must be supplied to specify DB type (CLDB, ELDB, etc.)

Format: DBA <fully qualified databasename> databasetype
COSI Rates File filename (must be supplied in SEQ File when needed)
COSI Titles File filename (must be supplied in SEQ File when needed)
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RUL

PGM

PPM

APP

STP #

RULes File for X210 (must be supplied if want to trigger auto editor
commands)

ProGraM to run in this step (non-Oracle Ultilities) (Fully Qualified and includes
any parameters to this program)

Program ParaMeters (optional) (Fully Qualified) - contains a single record of
parameters to be sent to program specified by PGMs.

Oracle Utilities Load Analysis Application to run. (the specific Applid of the
job) ex: X110 or X420, etc.

If the result, or return code from the program exceeds or equals # then the
stream will stop, Default = 99.



Load Data Management Subsystem

Load Data Management Subsystem
An asterisk (*¥) next to a keyword X110 - Dil‘ect Input - ValidatiOn - AUtOEditOl’

means the keyword is optional,

and may default. Keywords: Values or DBA Types Default (rodfiles - datfiles)
An asterisk (¥) next to a database APP X110
type means the database is
optional. DBA <fully qualified databasename> CLDB
DBA <fully gualified databasename> AXDB
CTL Filename (Data File)
ENV Filename
RUL * Filename No Default

X120 - Manual Entry

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X120

DBA <fully gualified databasename> ELDB

CTL Filename (Data File)

X170 - AXDB Summary Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X170

DBA <fully qualified databasename> AXDB

ENV Filename

X180 - AXDB Update

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X180

DBA <fully qualified databasename> AXDB

CTL Filename

ENV Filename

X210 - Cut Series Validation

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X210

DBA <fully qualified databasename> CLLDB

DBA <fully qualified databasename> AXDB

CTL Filename

ENV * Filename TGX21BENV
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RUL * Filename No Default

X220 - Invalid Cut Series Validation

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X220

DBA <fully qualified databasename> CLDB

DBA <fully qualified databasename> AXDB

CTL Filename

DBL Filename

X310 - Load Data Editor

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X310

DBA <fully qualified databasename> CLDB

DBA <fully qualified databasename> AXDB

CTL Filename

ENV * Filename TGX21B.ENV

RUL * Filename No Default

X320 - Load Data Editor Syntax Scan

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X320

DBA <fully qualified databasename> CLDB

CTL Filename

ENV* Filename

X370 - Individual Customer Analysis (CLDB) (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles — datfiles)
APP X370

DBA <fully qualified databasename> CLDB

CTL Filename

ENV Filename

DEM* Filename

CYC* Filename

HOL* Filename

TOU* Filename

SEA* Filename
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Load Data Management Subsystem

X400 - Time Series Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X400

DBA <fully qualified databasename> CLDB

CTL Filename

ENV Filename

X410 - Load Data Reporter (CLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X410

DBA <fully qualified databasename> CLDB

DBA* <fully qualified databasename> AL.DB

DBA* <fully qualified databasename> ALDB2

CTL Filename

ENV * Filename

HOL* Filename

TOU* Filename

SEA* Filename

X420 - Load Data Reporter (ALDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X420

DBA <fully qualified databasename> CLDB

DBA* <fully qualified databasename> AL.DB

DBA* <fully qualified databasename> AL.DB2

CTL Filename

ENV * Filename

HOL* Filename

TOU* Filename

SEA* Filename

X430 - Totalizing Reporter (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X430

DBA <fully qualified databasename> CLDB

CTL Filename

ENV Filename
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HOL* Filename
TOU* Filename

X440 - Summary Reporter (CLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X440

DBA <fully qualified databasename> CLDB

CTL* Filename

ENV Filename

X460 - Summary Reporter (ALDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X460

DBA <fully qualified databasename> CLLDB

CTL* Filename

ENV Filename

X470 - Late Cut Reporter (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X470

DBA <fully qualified databasename> CLLDB

CTL Filename

ENV Filename

X480 - Validation Statistics Reporter (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X480

DBA <fully qualified databasename>CILIDB

CTL Filename

X490 - CLDB Cut Series Gap Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X490

DBA <fully qualified databasename> CLDB

CTL* Filename

ENV Filename
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Load Data Management Subsystem

X491 - ALDB Cut Series Gap Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X491

DBA <fully qualified databasename> CLDB

CTL* Filename

ENV Filename

X530 - CLDB Cut Series Overlap Reporter

Keywords: Values or DBA Types  Default (rodfiles - datfiles)
APP X530

DBA <fully qualified databasename> CLDB

CTL* Filename

ENV Filename

X531 - ALDB Cut Series Overlap Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X531

DBA <fully qualified databasename> CLDB

CTL* Filename

ENV Filename

X620 - CLDB Load Data Transformation

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X620

DBA <fully qualified databasename> CLDB

DBA* <fully qualified databasename> CLDB2

CTL* Filename

ENV Filename

X660 - ALDB Load Data Retrieval

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X660

DBA <fully qualified databasename> CLDB

DBA <fully qualified databasename>ALDB

CTL* Filename

ENV* Filename
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Load Data Management Subsystem

X670 - Proxy Day Selection (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X670

DBA <fully qualified databasename> CLDB

DBA* <fully qualified databasename> CLDB2

ENV Filename

HOL* Filename

SEA* Filename

X710 - Statistical Package Interface

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X710

DBA <fully qualified databasename> CLDB

CTL Filename

ENV Filename

X720 - Direct Output (CLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X720

DBA CLDB, ALDB*, ALDB2*

CTL Filename

ENV Filename

X740 - Direct Output (ALDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X740

DBA <fully qualified databasename> ALDB

DBA* <fully qualified databasename> ALDB2*

CTL Filename

ENV Filename

X760 - Day Type Analysis (CLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X760

DBA <fully qualified databasename> CLDB

DBA <fully qualified databasename> ALDB
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Load Data Management Subsystem

DBA <fully qualified databasename> A1L.DB2
CTL Filename
ENV Filename
PEA* Filename
HOL* Filename
SEA* Filename

X770 - Day Type Analysis (ALDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X770

DBA <fully qualified databasename> AL.DB

DBA* <fully qualified databasename> ALDB2

CTL Filename

ENV Filename

PEA* Filename

HOL* Filename

SEA* Filename

X810 - Key Generator (CLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X810

DBA <fully qualified databasename> CLDB

CTL Filename

DBL Filename

ENV* Filename

KYS* Filename

X820 - Key Generator (ALDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X820

DBA <fully qualified databasename> CLDB

CTL Filename

DBL Filename

ENV* Filename

KYS* Filename
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Load Data Management Subsystem

X910 - Scan Archive/Delete

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP X910

DBA <fully qualified databasename> CLDB

DBA <fully qualified databasename> ALDB

CTL* Filename

ENV Filename

Q940 - Initialize Database (ELDB, SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Q940

DBA <fully qualified databasename> ELDB

DBA <fully qualified databasename> SL.LDB

ENV Filename

Q941 - Initialize Database (AXDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Q941

DBA <fully qualified databasename> AXDB

ENV Filename

Q942 - Initialize Database (CLDB, ALDB, GLDB, RLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Q942

DBA <fully qualified databasename> CLDB

DBA <fully qualified databasename> ALDB

DBA <fully qualified databasename> GLDB

DBA <fully qualified databasename> RLDB

ENV Filename

Note: To initialize the GLDB or RLDB Databases, use Q942 instead of Q943.

Note: For the Initialize Database programs, you must place the APP keyword before the DBA
command; otherwise the job will not run.

WARNING: Be extremely cautious when using the following Delete Database job, as zhere is no
way to “Undo” the delete action. Please back up any databases before you delete them.
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Load Data Management Subsystem

Note: For the Delete Database program, you must place the APP keyword before the DBA

command; otherwise the job will not run.

Q999 - Delete Database

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Q999
DBA <fully qualified databasename> CLDB, ALDB, AXDB, ELDB,

SLDB, GLDB, RLDB

Oracle Utilities Load Analysis Sequencer Program Input Tables and Keywords D-11



Load Data Analysis Subsystem

Load Data Analysis Subsystem

An asterisk (*¥) next to a keyword Q91 M - Move Cuts

means the keyword is optional,

and may default. Keywords: Values or DBA Types Default (rodfiles - datfiles)
An asterisk (¥) next to a database APP QI1M
type means the database is
optional. DBA <fully qualified databasename> CLDB, ELDB, SLDB, ALDB
CTL Filename
ENV Filename

Q91D - Delete Cuts

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Q91D

DBA <fully gualified databasename> ELDB. SLDB, CLDB, ALDB
CTL Filename

ENV Filename

Q91C- Copy Cuts

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP QI1C

DBA <fully qualified databasename> CLDB

CTL Filename

ENV Filename

Y110 - Customer Data Extraction

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y110

CTL Filename

CAF Filename

DBL Filename

Y120 - Customer Record Definition

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y120
CTL Filename
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Load Data Analysis Subsystem

Y130 - Direct Input (ELDB)/Enhanced Direct Input (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y130

DBA <fully qualified databasename> ELDB

DBA <fully qualified databasename> AXDB

CTL Filename (Data File)

ENV Filename

RUL* Filename No Default

Y220 - Manual Entry

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y220

DBA <fully qualified databasename> ELDB

CTL Filename (Data File)

Y230 - Billed Energy Program

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y230

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename

CYC Filename

Y240 - Load Data Extraction

Keywords: Values or DBA Types  Default (rodfiles - datfiles)
APP Y240

DBA <fully qualified databasename> CLDB

DBA* <fully qualified databasename> ALDB

DBA* <fully qualified databasename> ALDB2

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename
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Load Data Analysis Subsystem

Y310 - Standard Load Analysis

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y310

DBA <fully qualified databasename> ELDB
DBA <fully qualified databasename> CLDB2
BNV Filename

CTL Filename

ENV Filename

HOL* Filename

TOU* Filename

SEA* Filename

USD* Filename

Y320 - Aggregate Load Analysis

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y320

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename

HOL* Filename

TOU* Filename

SEA* Filename

Y330 - Ratio Analysis (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y330

DBA <fully qualified databasename> ELDB
DBA* <fully qualified databasename> CLDB2
BNV Filename

CTL Filename

ENV Filename

HOL* Filename

TOU* Filename

SEA* Filename

USD* Filename
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Load Data Analysis Subsystem

Y340 - Coincident Peak Analysis (Optional Extension)

Keywords:
APP

DBA

DBA

CTL

ENV

Values or DBA Types Default (rodfiles - datfiles)
Y340
<fully qualified databasename> ELDB
<fully qualified databasename> ALDB
Filename

Filename

Y350 - Domain Analysis (MPU) (Optional Extension)

Keywords:
APP
DBA
DBA*
BNV
CTL
ENV
HOL*
TOU*
SEA*
USD*

Values or DBA Types Default (rodfiles - datfiles)
Y350

<fully qualified databasename> ELDB

<fully qualified databasename> CLDB2

Filename

Filename

Filename

Filename

Filename

Filename

Filename

Y360 - Domain Analysis (Ratio) (Optional Extension)

Keywords:
APP

DBA

DBA

CTL

ENV
HOL*
TOU*
SEA*
USD*

Values or DBA Types Default (rodfiles - datfiles)
Y360

<fully qualified databasename> ELDB

<fully qualified databasename> CLDB2

Filename
Filename

Filename

Filename

Filename

Filename
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Load Data Analysis Subsystem

Y370 - Individual Customer Analysis (ELDB) (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles — datfiles)
APP Y370

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename

DEM* Filename

CYC* Filename

HOL* Filename

TOU* Filename

SEA* Filename

Y380 - 100% Sample Analysis

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y380

DBA <fully qualified databasename> ELDB

DBA <fully qualified databasename> CLDB2

CTL Filename

ENV Filename

HOL* Filename

TOU* Filename

SEA* Filename

USD* Filename

Y410 - Time Series Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y410

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename

Y420 - Load Data Reporter (ELDB)

Keywords: Values or DBA Types  Default (rodfiles - datfiles)
APP Y420

DBA <fully qualified databasename> ELDB

DBA <fully qualified databasename> SL.LDB

DBA <fully qualified databasename> SL.IDB2
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CTL Filename
ENV* Filename

Y430 - Load Data Reporter (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y430

DBA <fully qualified databasename> SLDB

DBA* <fully qualified databasename> SL.IDB2

CTL Filename

ENV* Filename

Y440 - Summary Reporter (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y440

DBA <fully qualified databasename> ELDB

CTL* Filename

ENV Filename

Y450 - Totalizing Reporter (Optional Extension)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y450

DBA <fully qualified databasename> E1LDB

CTL Filename

ENV Filename

HOL* Filename

TOU* Filename

Y460 - Summary Reporter (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y460

DBA <fully qualified databasename> SLDB

CTL* Filename

ENV Filename
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Y490 - Cut Series Gap Reporter (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y490

DBA <fully qualified databasename> ELDB

CTL* Filename

ENV Filename

Y491 - Cut Series Gap Reporter (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y491

DBA <fully qualified databasename> E1LDB

CTL* Filename

ENV Filename

Y530 - Cut Series Overlap Reporter (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y530

DBA <fully qualified databasename> ELDB

CTL* Filename

ENV Filename

Y531 - Cut Series Overlap Reporter (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y531

DBA <fully qualified databasename> ELDB

CTL* Filename

ENV Filename

Y620 - Load Data Transformation

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y620

DBA <fully qualified databasename> CLDB

DBA* <fully qualified databasename> CLIDB2

CTL Filename

ENV Filename

HOL* Filename
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TOU* Filename

Y630 - Load Data Editor (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y630

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename

Y710 - Statistical Package Interface

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y710

DBA <fully qualified databasename> ELDB

CTL Filename

ENV Filename

Y720 - Direct Output (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y720

DBA <fully qualified databasename> E1LDB

DBA <fully qualified databasename> SLDB

DBA <fully qualified databasename> SL.IDB2

CTL Filename

ENV Filename

Y740 - Direct Output (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y740

DBA <fully qualified databasename> SL.IDB

DBA* <fully qualified databasename> SLIDB2

CTL Filename

ENV Filename

Y760 - Day Type Analysis (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y760
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DBA <fully qualified databasename> ELDB
DBA <fully qualified databasename> SL.LDB
DBA <fully qualified databasename> SL.DB2
CTL Filename

ENV Filename

PEA* Filename

Y770 - Day Type Analysis (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y770

DBA <fully qualified databasename> SLDB

DBA <fully qualified databasename> SL.IDB2

CTL Filename

ENV Filename

PEA* Filename

Y810 - Key Generator (ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y810

DBA <fully qualified databasename> ELDB

CTL Filename

DBL Filename

ENV* Filename

KYS* Filename

Y820 - Key Generator (SLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y820

DBA <fully qualified databasename> ELDB

CTL Filename

DBL Filename

ENV* Filename

KYS* Filename
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Y910 - Archive/Delete

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y910

DBA <fully qualified databasename> ELDB

DBA <fully qualified databasename> SL.LDB

CTL Filename

DBL Filename

Y960 - Data Retrieval

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP Y960

DBA <fully qualified databasename> ELDB

DBA <fully qualified databasename> SL.LDB

CTL* Filename

ENV Filename
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Cost of Service Interface (Optional Extension)
An asterisk (*¥) next to a keyword G110 - Dil’ect Input (GLDB)

means the keyword is optional,

and may default. Keywords: Values or DBA Types Default (rodfiles - datfiles)
An asterisk (¥) next to a database APP G110
type means the database is
optional. DBA <fully gualified databasename> CLLDB
DBA <fully qualified databasename> AXDB
CTL Filename INP or LSE
ENV Filename

Z120 - Data Extraction (SLDB/ELDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP 7120

DBA <fully qualified databasename> GLDB

DBA* <fully gualified databasename> ELDB

DBA* <fully qualified databasename> SL.DB

DBA* <fully qualified databasename> AXDB

CTL Filename

ENV Filename

At least one database (an SLDB or an EI _DB) must be specified.

G130 - Energy Allocators

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP G130

DBA <fully qualified databasename> GLDB

CTL Filename

ENV Filename

HOL* Filename

G210 - Allocate Sampling Error

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP G210

DBA <fully qualified databasename> GLDB

DBA <fully qualified databasename> G1LDB2

ENV Filename

CRF Filename

HOL* Filename

TOU* Filename
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G250 - Allocate T&D Losses

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP G250

DBA <fully qualified databasename> GLDB

ENV Filename

CRF Filename

HOL* Filename

TOU* Filename

G410 - Rates Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
APP G410

DBA <fully qualified databasename> G1LDB

ENV Filename

CRF Filename

CTF Filename

HOL* Filename

TOU* Filename

G430 - Time Series Reporter

Keywords: Values or DBA Types Default (rodfiles - datfiles)
DBA <fully qualified databasename> ELDB

G440 - Summary Reporter (GLDB)

Keywords: Values or DBA Types Default (rodfiles - datfiles)
DBA <fully qualified databasename> CLDB

G610 - Cost Allocators

Keywords: Values or DBA Types  Default (rodfiles - datfiles)
APP G610

DBA <fully qualified databasename> G1LDB

DBA <fully qualified databasename> RLDB

ENV Filename

CRF Filename

CTF Filename

HOL* Filename
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TOU*
SEA*

Filename

Filename

G630 - Probability of Dispatch

Keywords:
APP

DBA

ENV
CRF*

CTF

GUF
HOL
TOU

SEA

Values or DBA Types
G630

<fully qualified databasename> GLDB
Filename

Filename

Filename

Filename

Filename

Filename

Filename

G670 - Proxy Day

Keywords:
APP

DBA

DBA

ENV
HOL

SEA

Values or DBA Types
X670

<fully qualified databasename> CLDB
<fully qualified databasename> CLDB2
Filename

Filename

Filename

G720 - Direct Output (GLDB)

Keywords:
DBA

Values or DBA Types
<fully qualified databasename> CLDB

G810 - Key Generator (GLDB)

Keywords:
DBA
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Appendix E

Using Oracle Utilities Load Analysis Sample
Data

Oracle Utilities Load Analysis provides new users the ability to execute much of the functionality
within the product using supplied data and pre-configured templates. This al;lows users to get
accustomed to how the application works using this sample data. This appendix describes how to
start using the system with this data, including:

*  Sample Data Provided
*  Prerequisites
*  Using The Sample Data In a Test Scenario
* Loading the Sample LSE and INP Files Into a Database

*  Running a procedure using the sample data and the templates
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Sample Data Provided

Oracle Ultilities Load Analysis v1.9.2 includes sample data allowing users to immediately begin
using the system with this data in a testing scenario. This data includes:

*  Load Data (interval data in INP and LSE format)
*  Template files preconfigured to match the load data

*  Default schedules such as TOU, season, and holiday that matches the templates and load data

Prerequisites

Before using this sample data with Oracle Utilities L.oad Analysis, ensure that the following
prerequisites have been met:

*  Oracle Utilities Load Analysis v1.9.2 client and server have been installed and are functioning
according to the Oracle Utilities Load Analysis Installation Guide.

*  Database connections and configurations completed and tested according to the Oracle
Utilities 1.oad Analysis Installation Guide.

*  The client must be able to log onto the server and successfully submit a job.

*  All database types (CLDB, ELDB, ALDB, AXDB, SLDB, GLDB) must be defined to the
server and available for selection on the GUI.

*  Standard installed template files must be unaltered located in the common\data folder on the
server. (.tem files)

*  Configuration files and sample data has been set up as described in Setting up
Configuration and Default files on page 1-13 in the Oracle Utilities Load Analysis Installation
Guide.
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Using The Sample Data In a Test Scenario

The following section describes the procedure to load the test interval data into non-production,

test databases and use that data to run reports, procedures, and analyses.

Loading the Sample LSE and INP Files Into a Database

The first jobs you should run are the X111 (Production Input) procedures. These procedures load
the interval data contained within the formatted LSE and INP files into the CLLDB, ALLDB and
ELDB databases. The CLDB database is a special database type that contains data that has not yet
been edited and/or validated ot copied to into the analysis database (ELDB). Validated data that
is as complete and accurate as possible is stored in the ELDB databases. The ALDB database is
an archive type database used to archive older data from the CLDB.

Use the following procedure to load sample data.

1.

AN A T

10.

11.
12.
13.

Navigate to the Production Input submit screen by expanding the Input branch and clicking
on the X111 (production Input) selection. This will change the submit screen to allow you to
select INP and LSE files, select input configurations and databases.

Select your test CLDB database (TEST CLDB) in the Interval Database drop-down list.
Select the SAMPLECLDB.LSE file in the Load Data drop-down list.

Check the Combine Reports checkbox.

Leave all options as is.

Click on the new Environment File button (This is the last button on the Environment file
line in the center frame) to open the composer. The composer will assist you in creating a
load configuration. During this exercise, we will use the template.

Click on the Template button to load the template containing "LOA REP"

Save the configuration to whatever filename you desire. (TSTX11B.ENV is what we will use
in this example).

Click the Submit button to display the Job Parameters screen that names the job and submits
the procedure to the server for execution.

Leave all fields as defaulted and click OK.

This starts the execution of the procedure, creates a job folder shown in the Results frame,
and adds an entry to the queue frame. If the server is configured propetly the input job will
run successfully. You should notice a zero return code in the queue frame once the
procedure has completed.

Click the entry in the results frame to highlight the report in the results file folder display.
Open the report and view it to ensure that the data was loaded propetly.

Repeat the procedure for the other three sample files (outlined in the table below) until all
data (Ise and .inp files) has been successfully loaded into the appropriate databases.

You will need to adjust the environment file for each file based on the table below. You may
get some informational messages about DST, these messages are OK with this data unless the
data is not imported.

Database Selection Load Data File Env options to use
CLDB SampleCLDB.LSE LOA REP (use template)
ELDB SampleELDB.LSE LOA REP VAL

GLDB SampleGLDB.LSE LOA REP VAL
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Database Selection Load Data File Env options to use
GLDB SampleGLDB.INP LOA REP VAL
DST A

Running a procedure using the sample data and the templates

You are now ready to run procedures, reports, and analysis using the test data and the supplied

templates. The steps outlined below may be applied to most other Oracle Utilities L.oad Analysis

procedures.

How to execute Load Analysis procedures:

1.

8.
9.

Start by selecting the procedure you are interested in running from the left-hand tree selector.
In this example we will be running a Ratio Analysis on the validated data located in the ELDB
database using the templates.

Expand the Analysis branch on the main screen to show the analysis procedures and select
Ratio Analysis. In the configuration and selection frame select the ELDB you just loaded
the SampleELDB.LSE data.

Select none for the Target Database.

Create a new Control File by clicking on the Create New File button on the Control file line.
This will open the composer for Ratio Analysis.

Click on the Template button to populate the file with the configuration that matches the
sample data.

Close the file and save it as any filename you wish.

Repeat steps 3 - 5 to create a new Environment file. There are two examples in this template.
You must select one and comment it out prior to saving the file. You do this by selecting the
example and clicking on the comment button. (The second configuration is commented out.)

Leave all other selections as "default".

Click on the Submit button to run the procedure.

10. View the analysis results and graphs.
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